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What's new

New features in the Kiteworks Web application

New features in the Kiteworks Web application

Message security setting enhancements

When composing messages, the "Protect message body" security setting has changed to "Recipients
must sign in to view the message body and file attachments list". This clearly describes the function of
the setting and is the recommended security setting.
Exposing the message body and file attachments list to non-authenticated users reduces security. Any
user who receives a forwarded copy of the message can view the message. You also lose the ability to
track and withdraw the message.

Messages are always sent securely through Kiteworks. If you choose to allow non-authenticated
users to view the message body and file attachments list, they will still be required to sign to download
the file attachments.

Message Security Settings X
Who has access to your sent content (including forwards) @
Original recipients only (Secure)

Allow recipients to use one-time passcodes to access the message

Recipients must sign in to view the message body and file attachment list

See Send messages.

Shared files enhancements

When navigating to the Shared With Me page to view files that have been shared with you, an Updated
column has been added to show the date the file was last updated.

Shared with me
Information &
Tracked Activity
Name ¢ Shared % Updated % Size ¥ 9 Tracked Activity
@ Annual Report.docx Today, 3:57 PM by Test Manager | Today, 3:56 PM by Test Manager |222.7 K& 2 & e
8= Expense Spreadsheetxlsx Today, 3:57 PM by Test Manager | Today, 3:56 PM by Test Manager |65.6 KB / & 4 wes
Project Scope Report.pdf Today, 3:56 PM by Test Manager| Today, 3:55 PM by Test Manager |34.7 kB b e

See View files shared with you.

Accessibility improvements

Accessibility improvements have been made for compliance with Web Content Accessibility (WCAG) 2.0
AA.
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Get started

System requirements

System requirements

Operating system

Any of the following versions, along with the latest updates.
e Mac OS X 10.8 (Mountain Lion) or later

e Windows 11

e Windows 10

e Windows 8.1

Browsers

e Chrome 73 or later

o Firefox 84 or later

e Microsoft Edge 75 or later
o Safari 13.1.2 or later
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Get started
Sign in to the Kiteworks Web application

Sign in to the Kiteworks Web application

Once you've created or activated your user account, sign in to the Kiteworks Web application to access
shared folders, download files, view secure messages, and more.

If you're signing in using certificate-based authentication, see Sign in using certificate-based
authentication.

To sign in:
In a web browser, enter the address of your Kiteworks server.

(Optional) Select the language you want for the web application. The change takes effect immediately
and changes the language on the sign-in page for subsequent sign-ins. The setting is controlled by a
browser cookie and expires after 30 days, or when you manually clear your browser cookies.

Type the user name or email address associated with your account, and then click Next.

When LDAP or single sign-on policies are in place for your company, you typically enter a user
name instead of an email address. If you don't know your user name, contact your Kiteworks
administrator for assistance. You may also see a Contact Us link on the page for contacting your
Kiteworks administrator.

If you receive a "Missing mandatory parameter" message, inform your Kiteworks administrator that
the server needs to be updated with the latest version before you can sign in.

Type your password, and then click Sign In.

If you forgot your password or need to change it, click the Forgot Password link and then
follow the prompts reset your password.

If this is your first time signing in and two-factor authentication is required, follow the screen
instructions to set it up.

o If text-based authentication (SMS) needs to be set up, you'll be prompted to provide a mobile
number for your account. Enter the mobile number and when the passcode is texted to your
phone, enter the code into the box on the sign in screen.

o If time-based, one-time password (TOTP) needs to be set up, use your phone to scan the barcode
on the setup screen to an authenticator app, and then enter the code returned by the
authenticator app. For detailed instructions, see Set up time-based, one-time passwords.

e For other authentication methods, no set up is required. For example, a passcode may be emailed
to your account, or other credentials using mechanisms such as RSA token or YubiKey may be
required to verify your identity. Just enter the information required to sign in.

When two-factor authentication is required, each time you sign in you'll need to enter a new passcode
sent by email, text, or generated by an authenticator app. For faster sign in, your Kiteworks
administrator may allow you to skip this step. On the sign in screen, click the "Remember this device"
check box to temporarily add your computer or phone as a trusted device.

If you enter an incorrect user name or password, your Kiteworks administrator may require you enter a
CAPTCHA code for further verification. Verify your user name and password, and then type the code
shown on the screen to finish signing in.

If you enter an incorrect password too many times, your user account may get locked. If this happens,
you'll be notified by email. You can wait for a period of time and then try to sign in again or contact your
Kiteworks administrator for assistance. Your Kiteworks administrator determines how many times you
can enter an incorrect password before your account gets locked, and how long it remains locked before
you can sign in again.

To sign out:

In the upper right corner of the screen, click your user name, and then click Sign Out.
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Get started

Sign in using certificate-based authentication

Sign in using certificate-based authentication

If your Kiteworks administrator provides certificate-based authentication as a sign in method, you can
sign in with a trusted certificate installed in your browser, instead of your username and password.

e Add trusted certificates in a browser

e Sign in using certificate-based authentication

Add trusted certificates in a browser

Before you can sign in using certificate-based authentication, you must first get the certificate, and the
password used to encrypt it, from your Kiteworks administrator. Then, add the certificate to your
browser's trust store. You only need to do this once.

To add a certificate in Chrome:

Open the browser Settings page.

Click Privacy and Security > Security > Manage Device Certificates.

In the Certificates box, go to the Personal tab, and then click Import.
Select the certificate you want to add.

Enter the password used to encrypt the certificate.

Add the certificate to the Personal store.
To add a certificate in Firefox:

Open the browser Settings page.

Click Privacy & Security.

Scroll to the Security section.

Under Certificates, click View Certificates.

In the Certificate Manager, go to the Your Certificates tab and click Import.
Select the certificate you want to add.

Enter the password used to encrypt the certificate.

Click Sign In.

To add a certificate in Microsoft Edge:

Open the browser Settings page.

Click Privacy, Search, and Services.

Scroll to the Security section.

Click Manage Certificates.

In the Certificates box, go to the Personal tab, and then click Import.
Select the certificate you want to add.

Enter the password used to encrypt the certificate.

Add the certificate to the Personal store.
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Get started

Sign in using certificate-based authentication

Sign in using certificate-based authentication

To sign in using certificate-based authentication:

In a web browser, enter the address of the Kiteworks application.

Follow the browser prompts to select the certificate for signing in to the server.

If you've installed multiple certificates, when signing in for the first time the browser displays a list of
certificates for you to choose from.

Select a certificate

Certificate information

Select a certificate to authenticate yourself to server.example.com:443
Subject ssuer Serial
Test User server.example.com 00 89 ea 63 Of d7 3¢ <8 a3

canee

On the sign in screen, click the link provided for certificate-based authentication. The link text may

have been customized by your Kiteworks administrator.

Your Kiteworks administrator may configure certificate-based authentication to bypass

the sign in page and automatically sign you in to the server.

Sign in

Username or email

Kiteworks

Subsequent sign ins may not require you to select the certificate each time if you keep the browser
open. This behavior is controlled by the browser. If you close and reopen it, when you connect to the

server, you may be prompted to select the certificate again.

If you receive an error when signing in with a certificate, contact your Kiteworks administrator. If your
certificate is no longer valid, they will need to provide you with an updated certificate.

Kiteworks Web User Guide
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Get started

Change your password

Change your password

If someone created a password for you, you should change it immediately so that your account is secure.
If you need to change your password, you can reset it in your profile settings.
If you are using LDAP or single sign-on (SSO) for authentication, contact your Kiteworks
administrator to change your password.
To change your password:
In the upper right corner of the screen, click your profile picture, and then click Settings.
On the Account tab, change your password, and then click Submit.

To test your new password, sign out and then back in again.
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Get started

Set up time-based, one-time passwords

Set up time-based, one-time passwords

For two-factor authentication (2FA), your Kiteworks administrator may require you to use a time-based,
one-time password (TOTP) when signing into the Kiteworks Web application. TOTP is used by
authentication apps to generate one-time numeric passwords that remain valid for 30 seconds. It
provides extra security when authenticating your account.

Your Kiteworks administrator determines whether you must use TOTP. You'll see the TOTP setup screen
the next time you sign into the web application. Use your phone to scan the barcode on the setup
screen, and then enter the code returned by the authenticator app. Each time you sign in you'll need to
enter a new passcode generated by the authenticator app. Your Kiteworks administrator may provide an
option for you to remember your device settings so that you can skip this step.

The following authentication apps have been tested, although you can use any app that supports the
TOTP standard.

e Microsoft Authenticator

e Google Authenticator

e FreeOTP Authenticator (Red Hat)
e Twilio Authy

e Duo Mobile

o LastPass Authenticator

e Onelogin Protect
To set up time-based, one-time passwords:

Sign into the Kiteworks Web application.

When prompted to set up TOTP, open the authenticator app on your phone and scan the barcode to
the app.

e You may be able to use your device camera to scan the code to the app.

e To manually get the code, click “Having trouble scanning the code?". Copy the secret key and
enter it into your account in the authenticator app.

Enter the code from your authenticator app, and then click Submit.

A secret key is associated with your device and user account.

Two factor authentication
Setting up time-based OTP

9:56

= Authenticator

irving.collaborator@accellion.com

880 909 &

Submit

Kiteworks Web User Guide Page 14



Get started

Set up time-based, one-time passwords

Reset your secret key

If you get a new phone or want to use a different authenticator app, you need to reset the secret key
associated with your device and user account.

To reset your secret key:

Open the Kiteworks Web application.
In the upper right corner of the screen, click your profile picture, and then click Settings.
On the Account tab, next to Time-based OTP, click Change Phone.

Account Preferences

Display name

Mobile number

Y

Password

To madify your password, please contact your administrator.

Time-based OTP

Change phone

Enter the password you use to sign into the web application, and then click Retrieve New Code.
Open the authenticator app on your phone and scan the barcode to the app.
¢ You may be able to use your device camera to scan the code to the app.

o To manually get the code, click “Having trouble scanning the code?". Copy the secret key and
enter it into your account in the authenticator app.

Change phone for time-based OTP X

1. Enter your
password to proceed

2. Scan the following
QR code in your
authenticator app

Having trouble scanning the code?

3. Enter the 6-digit
code you see in your
authenticator app

Enter the code from your authenticator app, and then click Verify.

A new secret key is associated with your device and user account.
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Get started

Search for files, folders, and content

Search for files, folders, and content

To find information in the Kiteworks Web application, use the Search box at the top of the page.

You can search for content such as file and folder names. Your Kiteworks administrator may also expand

your search capability to include the following:

o Folder, file, and mail metadata -- that is, folder names, file names, content in mail subject lines and
mail body text, and mail file attachment names.

¢ File content, including in mail file attachments.

In your search, you can use built-in filters to narrow your search to only mail messages, file names, or

folder names. To access built-in filters, click in the Search box, select the filter, and then enter the search

text.

Q Search content in

Kiteworks

Search in:

Subject

From

To

File name search by file name

File content

Folder name

Accepts commaon search operators: ", AND, OR, NOT See more

Search results are organized by files, folders, and inbox messages. Up to 50 search results are returned,
starting with the most recent occurrence of the search term. If search is unable to find a term, the search
results page offers a suggestion for finding the term or a similar one.

Searches exclude files that have been flagged as possibly containing viruses or that contain information
that your Kiteworks administrator identifies as sensitive or private by your company.
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Get started

Search for files, folders, and content

When searching for a word or phrase in a file name, folder name, or message subject, the search term is

highlighted in the search results.

Q event

Files (1) Folders Inbox Messages

7. SORTBY | Best Match ~

Event Flyer.docx
Wi Added on Oct 1, 2024, 10:34:11 AM

My Folder = Event Flyer.docx

Sent Messages

found in a file. Click the file to open it in the viewer.

When searching in file content, search results display "MATCHED WITH CONTENT" when the term is

FILE CONTENT ~ financial summary

Files (2] Folders Inbox Messages

1L SORTBY | Best Match v |

Annual Report.docx
Added on Sep 16, 2024, 1:03:37 PM
My Folder > Annual Report.docx

MATCHED WITH CONTENT

Sent Messages

Kiteworks Web User Guide
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Get started

Search for files, folders, and content

Partial word search

To search for a word, type the first few letters of the word.

Q ann

Inbox Messages Sent Messages

Files (2] Folders
7l SORTBY | Best Match ~
Annual Report.docx
(W] Added on Sep 16, 2024, 1:.03:37 PM
My Folder = Annual Report.doc

Exact match search
To search for an exact file name or phrase, surround the text with quotation marks.

X

Q, “Annual Report.docx”

Folders Inbox Messages Sent Messages

Files (1)

Tl SORTBY | BestMatch

Annual Report.docx

WIS 142

PM

[¥5]

L e

W] Added on Jan 15,

Sandstone Project > Annual Report.doo

Page 18
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Get started

Search for files, folders, and content

Use Boolean operators in your search. Operators are AND, OR, and NOT. Operators are case-sensitive.

Table 1. Boolean operators

Operator  Usage

AND Use AND between terms to return results containing both terms.

"project AND report" will return results containing both "project" and "report".

Q project AND report

Files (2) Folders

tl SORTBY

Coldwater Project Annual Report.docx
W] Ad by Test

Inbox Messages Sent Messages (1)

x

"report".

OR Use OR between terms to return results containing either of two terms.

"project OR report" will return results containing the term "project" or

Q project OR report

Files (2) Folders (3)

tl SORTBY

ocxX

Sandstone Project » Geographic Report.docx

Inbox Messages Sent Messages (2)

07:40 AM by Test Manager

X

Kiteworks Web User Guide
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Search for files, folders, and content

Table 1. Boolean operators (continued)

Operator  Usage

NOT Use NOT between terms to exclude results containing the term.
"project NOT report" will return results that do not contain the term "report".

Q project NOT report x

Files Folders (2) Inbox Messages Sent Messages

Hawthorne Project

Kiteworks » Hawthorne Project

Kiteworks Web User Guide Page 20



Customize your workspace

Kiteworks Web User Guide Page 21



Customize your workspace

Edit your account profile

Edit your account profile

You can edit your account profile to upload a profile photo, change your display name, monitor your
folder and file storage quota, and change your password.

To edit your account profile:

In the upper right corner of the screen, click your profile picture, and then click Settings.
On the Account tab, edit your profile, and then click Submit.

Table 2. Account profile settings

Setting Description

Profile picture Upload an image up to 2 MB in one of these formats: .gif, .jpg, .jpeg, and .png.

The image becomes your profile photo in the Kiteworks Web application and in
the mobile app on any devices you use to access the web application.

Display name Enter a custom name to display in the application. Otherwise, your email address
is displayed.
Your display name appears in places such as the Members pane when viewing a
list of folder members for a shared folder. Other users see your display name in
places such as the Information & Tracked Activity pane when viewing your
activity for a shared folder.

If you are using LDAP or single sign-on (SSO) for authentication,
contact your Kiteworks administrator to change your display name.

Email Only your Kiteworks administrator can change your email address.

Mobile number The mobile number associated with your account, provided by you or your
Kiteworks administrator.

Your mobile number may be used as an extra step to confirm your identity when
two-factor authentication is required for signing into the server.

It may also be used when a user sends you a message on the server. They may
text you a one-time password for you to access the message and file links instead
of signing in to access them.

To change your mobile number:

Next to your mobile number, click Edit .
Type your new number, and then enter your Kiteworks password.

If you want to verify your new number, click Test to send a text message to
the new number.

Click Save.
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Customize your workspace

Edit your account profile

Table 2. Account profile settings (continued)

Setting Description

Usage The amount of space your Kiteworks administrator allocated for your folders and
files. Only the folders and files you own comprise your allowable quota. If you
need to free up some storage, here are some ways to do it:

o Delete your unnecessary folders, files, and file versions. Deleting folders and
files owned by other users will not free up your storage space.

e Permanently delete folders and files you no longer need to save for recovery.

You can also ask your Kiteworks administrator to increase your storage quota.

Change password  If permitted by your Kiteworks administrator, you can change your password at
any time.

Time-based OTP If you use an authenticator app to get verification codes for signing into the web
application, you can reset the secret key associated with your device and user
account. For example, if you get a new device or want to change the
authenticator app you use, you may want to reset your secret key.

To change your secret key:

Click Change Phone.

Enter the password you use to sign into the web application, and then click
Retrieve New Code.

Open the authenticator app and scan the barcode to the app. You may be able
to use your device camera to scan the code to the app.

To manually get the code, click “Having trouble scanning the
code?". Copy the secret key and enter it into your account in the authenticator
app.

Enter the code from your authenticator app, and then click Verify.

A new secret key is associated with your device and user account.

Kiteworks Web User Guide Page 23



Customize your workspace

Define your Kiteworks preferences

Define your Kiteworks preferences

You can change your default preferences to accommodate your work style. For example, you can create
an email signature for messages that you send from Kiteworks.

To define your preferences:

In the upper right corner of the screen, click your profile picture, and then click Settings.
On the Preferences tab, define your preferences, and then click Submit.

Table 3. Preferences tab options

Setting Description

Language Select the language you want for the web application. The language setting also
appears on the web application sign-in page.

You can also select the language when signing in to web application.
However, when you set the language from the sign in page, the setting is
controlled by a browser cookie and expires after 30 days, or when you manually
clear your browser cookies.

Preferred storage* Select the preferred location of the server used for storing file uploads and
downloads. For assistance, contact your Kiteworks administrator.

Message signature Type an email signature to include in messages you send from the Kiteworks Web
application. To format your signature, you can use these HTML tags: <b>, <i>,
<u>.

The HTML code displays in your draft messages and the HTML formatting displays
in recipient email messages.

Keys for SFTP Secure File Transfer Protocol (SFTP) keys provide alternatives to entering

Login* passwords. You can generate a list of keys for accessing your account or you can
import your own private keys. Once you enable SFTP, you can generate or add
SFTP keys.

Your key is unique to your user account. To avoid problems with accessing your
account, do not share your keys with other users.

To generate an SFTP key:
Click Generate SFTP Key.

Type a key name and pass phrase, and then click Generate.
Copy the public and private keys and store them in a secure location.

To add an SFTP key:

Click Add SFTP Key.
Type the key title, and then enter or paste the key into the key field.
Click Generate.

*Your Kiteworks administrator determines whether this setting is available to you.
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Add Repositories Gateway sources

Add Repositories Gateway sources

You can access content from storage systems such as SharePoint and Windows file shares, and from
cloud storage services such as Microsoft OneDrive for Business, Box, and Dropbox. Connecting to
Repositories Gateway sources from the Kiteworks Web application enables you to securely edit,
download, and share external content from a single location.

Your Kiteworks administrator determines whether you can add a content source. If so, you will see the
"New content source" button at the top of the All Files page.

Your administrator also determines which sources you can add and may need to add some sources for
you, such as Dropbox and Microsoft OneDrive for Business. When this happens those sources appear in
the list automatically.

Gather information needed to connect to the source. For example, you may need a server
address or path to connect to the source, and possibly a user name and password to sign into the source.

All Files

_f, Upload v ‘ —+ New content source

Updated

u
o Kiteworks
L Google Drive
&@a, OneDrive

:.: Dropbox
&> Salesforce

E‘ SharePoint Online
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Add Repositories Gateway sources

To add a Repositories Gateway source:

In the navigation pane, click All Files, and then click New Content Source.
On the Add Repositories Gateway source page, select the source you want to add.
Provide the source connection information, and then click Add.

Source names can't contain these characters: \ /: *? " <> |

Add Repositories Gateway source X
Source type
SharePoint v

Source name

<Custom name for the source>

Source URL

<The URL for accessing source content>

Description (Optional)

To remove a Repositories Gateway source:

On the All Files page, select the checkbox next to the source name, and then click Remove Repositories
Gateway Source.

Only your Kiteworks administrator can remove cloud storage sources from the list.
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Add connections to SharePoint Online sites

Add connections to SharePoint Online sites

If you're using Microsoft SharePoint Online to share and collaborate with others, you can search for and
add connections to SharePoint sites to the All Files page. Connections appear in the list of external
sources on the All Files page and are only visible to you.

Your Kiteworks administrator determines whether you can add SharePoint connections to the All Files
page. Also, you must be signed in using an LDAP user account. If you don't see the SharePoint Sites link
at the top of the search results page and you need to add connections, please contact your Kiteworks
administrator for assistance.

To add a connection to a SharePoint Online site:

In the search box at the top of the page, search for the site you want to add.
You can enter a general term to get a list of sites that contain the search term.
On the search results page, click the SharePoint Sites link to see your search results.
Next to the site you want to add, click Add Site.
The site is added to the All Files page.

To remove a connection to a SharePoint Online site:

In the search box at the top of the page, search for the site you want to remove.
On the search results page, click the SharePoint Sites link to see your search results.
Next to the site you want to remove, click Remove Site.

The site is removed from the All Files page.
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Add and remove contacts

Add and remove contacts

You can create a list of email addresses for collaboration, and then select the emails you want when
composing your message.

Each contact can have multiple email addresses. When composing your message, just select the address
you want to use.

You can also add a contact just by sending a message. If a recipient's email address is not already in your
Contacts list, their address gets automatically added to the list.

To add a contact:

In the navigation pane, click Contacts.
On the Contacts page, click Add Contact.
Type a name for the contact.
Type one or more email addresses for the contact, and then click Submit.
If LDAP policies are in place at your company, you can also search your company
directory for a person's email address.

To edit a contact:

On the Contacts page, click the contact you want to edit.
Edit the contact details, and then click Submit.

To delete a contact:
Select the contact you want to delete, and then click Delete.

If the contact is part of a group, it is not automatically deleted from that group. To delete it, click the
name of the group you want to edit, delete the contact, and then click Submit.
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Create and edit groups

You can create groups of users to select when sending bulk messages.
To create a group:

On the Contacts page, click Add Group.
Type a name for the group.
Group names can't contain these characters: \/: *?"<> | &
Enter the email addresses of the recipients you want to add to the group, and then click Submit.

As you type, suggestions are made from your Contacts list in the Kiteworks Web application.
You may also be able to search your company directory for an address. New addresses are added to
the contacts list.

To edit a group:

On the Contacts page, click the name of the group you want to edit.
Edit the group, and then click Submit.

To delete a group:
On the Contacts page, select the name of the group you want to delete, and then click Delete.
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View and manage messages in your inbox

View and manage messages in your inbox

Your inbox organizes your emails and notifications in one place. In your inbox, emails are messages you
send and receive using your Kiteworks user account, such as when you send files or request files from
others. Notifications are system generated messages that inform you of a specific event, such as when

someone downloads a file you sent them, uploads a file to a shared folder, comments on a file, and so
on.

Your Kiteworks administrator determines whether you receive Kiteworks emails and notifications in your
inbox, in your external email, or in both places.

Kiteworks Web User Guide Page 31



Manage your inbox

Send messages

Send messages

To send a message:

In the navigation pane, click Compose.
If you're sending the message from a shared mailbox, select the mailbox in the From list.
If you're filling out a form, click the Fill Out Form link, and then select the form.

Your Kiteworks administrator may set a form to open automatically when you compose a
message. You can click the Fill Out Form link to select a different form or to compose an email
message instead.

Enter the email addresses of the recipients.

As you type, suggestions are made from your Contacts list in the Kiteworks Web application.
You may also be able to search your company directory for an address. New addresses are added to
the contacts list.
If you're filling out a form, a predefined email address may get entered for you.
Compose your message or complete the form, and then attach any files or folders you want to send.

The maximum allowed size of all folder attachments is 1.3 GB. Your Kiteworks administrator
may lower the size limit.
If you want to allow others to track the message activity, click the Tracking Access link. In the Tracking
Access row, click next to the information icon and enter the email addresses of the users you want to
have tracking access. See Allow others to track message activity.
To set an expiration date for file attachment links, add security and more, click the Message Security
Settings link at the top of the page.
Click Send.

As the message is processed, it's stored in the Kiteworks Outbox folder. Files are scanned for
security, so it may take a moment for the message to be sent. If a recipient doesn't receive your
message in their external email application, ask them to check their spam or junk email folder to
determine if the message was misidentified.
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Compose Message

@ Message Security Settings:

( Eill Qut Forms )

Access: Original recipients only. Message Body: Protected.
Attachments: Expire Oct 19, 2023

Manage your inbox

Send messages

Increase security, set

To "Irving Collaborator” X

Cc

Project files

attachment expiration
date, and more.

Select and pin sources

& attachfies: B | B | G|l & | @& | e

x| B I U §

i
]

sans-serif =

Here are the files we discussed at today's meeting.

Attachments: 2 items
(Expire: Dec 31, 2022)

Annual Report.doox
(222.1 KB)

Sandstone Project Folder.

. o X
zip (58.6 MB)

from which to attach
files.

Table 4. Message settings

Setting* Description

Who has access to
your sent content
(including
forwards)

Specify who can access the message, including when it's forwarded to others.

Your Kiteworks server administrator determine which options are available to
you, including the ability to allow recipients to access the message using one-time
passcodes.

Allow recipients to
use one-time-
passcodes to
access the
message

Send recipients one-time passcodes to access the message instead of signing in
with their user names and passwords. Recipients will still have the option to sign
in or create an account to access the message.

Depending on the options available to you, you may be able to email or text
recipients the one-time passcodes. If texting passcodes, when you send the
message you'll be prompted to enter or confirm mobile numbers.
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Table 4. Message settings (continued)

Setting* Description

Recipients must Require recipients sign in to view the message body and list of file attachments. If
sign in to view the the user does not have an account on the server, they'll be prompted to create
message body and one to view the message.

file attachments In your Sent & Tracked folder, the @ indicates a secure message.

list
Select this option to enhance security. Exposing the message
body to non-authenticated users allows any user who receives a forwarded copy
of the message to view the message and list of file attachments. You also lose the
ability to track and withdraw the message.
If you don't select this option, the message is still sent securely through
Kiteworks. While non-authenticated recipients will see the list of file attachments,
they will need to sign in to download the file attachments.
The subject line will be visible to recipients.

Attachments Links expire on the date you specify at 23:59:59 (11:59:59 PM) UTC time.

expire

Notify me when Email yourself a report listing the files that expired and whether recipients

attachments opened, downloaded, or copied them to a folder.

expire You don't need to wait until files expire to track their activity. After sending

files, open your Sent & Tracked folder in the Kiteworks Web application and next
to the message click Track.

Display the SHA3-  Include an SHA3-256 digital fingerprint with each file attachment for those

256 digital recipients who want to verify the integrity of the file. Recipients can use a third-
fingerprint next to  party tool to verify that each file has not been altered.

each file

attachment

Notify me when Email yourself a time-stamped notification that includes the name of the file and

attachments are the email of the person who downloaded it. You can also choose to notify other
downloaded. Also  users as well.
notify:

Send attachments  Allow authorized recipients to view the files, but not download them. To view the
as view-only files  files, they must sign into the server.

Send attachments Allow authorized recipients to view the files, while preventing them from
as DRM protected  copying, printing, or modifying the files in any way.

files Recipients view DRM protected files in the secure Kiteworks viewer. They can
open the files directly from their email messages and download links to the files
for use later. To view the files, they must sign into the server.

Send me a copy Email yourself a copy of the message.

* Your user profile on the Kiteworks server determines which settings you can see and can modify. For
assistance, contact your Kiteworks administrator.
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Pin and unpin sources

When attaching files to messages, you can pin the sources you access most often to the message
composer.

To pin a source:

On the Attach Files toolbar, click *+¢.
Next to the source you want to pin, click Pin

To unpin a source, click the pin again.

Compose Message (FillOut Forms)

© Message Security Settings:  Access: Original recipients only. Message Body: Protected,
Attachments: Expire Oct 19, 2023

Select files X
To ‘"Irving Collaborator” X Bec Recents Files Favorites
Cc Online files
Project files G Kitewaorks l_ ]
|
& atachriles: B 1B |Gl & | @ | o | sansseiifv 14+« | B I U 8§ = | ~ | L Google Drive x
& OneDrive —x

Here are the files we discussed at today's meeting.

>
@® Drop box
&» salesforce

E_D SharePoint Online

Kiteworks Web User Guide Page 35



Manage your inbox

Add and use shared mailboxes

Add and use shared mailboxes

A shared mailbox is used to send email to a group of people, such as support email list. Only members of
the shared mailbox can send and receive email from the account.

If your Kiteworks administrator adds you as a member of a shared mailbox, the mailbox appears on the
Shared Mailbox tab in your account profile settings and in the navigation pane.

Settings

Account Preferances Shared Mailbox

Enable Shared Mailbox sharedmailbox@company.com

/‘Compuse =

= sharedmailbox@company.com
= irvina.collaborator@kiteworks.com
ALL FILES

Recents

Shared with me

Favorites
When using shared mailboxes, keep the following information in mind:

e Email in the Inbox and Sent & Tracked folders is accessible to all members of the shared mailbox. The
Sent & Tracked folder also provides members with information such as the date and time email was
received, along with email expiration dates.

e When composing a message, you can switch mailboxes. If you have draft content in the message, it
gets saved to the Drafts folder for the account before the switch occurs. If you want to switch
accounts and carry over draft content to the new account, first copy the content. Then switch
accounts and paste the content into the new message composer.

To switch mailboxes when
compaosing email, click the
From button.

From sharedmailbox@company.com ——

irving.collaborator@kiteworks.com i

sharedmailbox@company.com

o If you're also using the Kiteworks for Outlook Desktop plugin to send email through Kiteworks, you
can securely send and receive mail using a shared mailbox directly from your Outlook client. The
plugin will automatically detect and add up to five shared mailboxes that you have enabled in the
Kiteworks Web application.
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Add and use shared mailboxes

In the upper right corner of the screen, click your profile picture, and then click Settings.

On the Shared Mailbox tab, select the Enable Shared Mailbox checkbox next to the account you want

to enable, and then click Submit.

The shared mailbox is added to the navigation pane.

To send a message from a shared mailbox:

In the navigation pane, click the shared mailbox. Then click a folder in the mailbox, such as the Inbox
folder, to switch the focus to the new mailbox.

/‘Cumpuse =

= sharedmailbox@company.com
irving.collaborator@kiteworks.com

All Files

Recents

Shared with me

Favorites

Click Compose.

Click the shared mailbox you want
to use. Then you can compose
your message and access mailbox
folders.

Enter the email addresses of the recipients.

As you type, suggestions are made from your Contacts list in the Kiteworks Web application.
You may also be able to search your company directory for an address. New addresses are added to

the contacts list.

Compose your message, then attach any files or folders you want to send.

The maximum allowed size of all folder attachments is 1.3 GB. Your Kiteworks administrator

may lower the size limit.

To set an expiration date for file attachment links, add security and more, click the Message Security

Settings link at the top of the page.
Click Send.

As the message is processed, it's stored in the Kiteworks Outbox folder. Files are scanned for
security, so it may take a moment for the message to be sent. If a recipient doesn't receive your
message in their external email application, ask them to check their spam or junk email folder to
determine if the message was misidentified.

If a recipient doesn't receive your message in their external email application, ask them to check their

spam or junk email folder to determine if the message was misidentified.

To remove a shared mailbox from the navigation pane:

In the upper right corner of the screen, click your profile picture, and then click Settings.

On the Shared Mailbox tab, clear the Enable Shared Mailbox checkbox next to the account you want

to remove, and then click Submit.
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Mark addresses as external distribution lists

You can send secure email to external distribution lists in a way that allows recipients in the target
domain to access those messages. Recipients will need to sign in to view the messages. If they don't have
an account, they'll be prompted to create one.

When you mark an address as an external distribution list, the server doesn't have access to the email
addresses in that list. It knows only the email domain of the list. Because of this, recipients won't receive
those messages in their Kiteworks inbox. Instead, they'll read the messages in a stand-alone viewer.

Any recipient of the message can access it using an email address at the same domain. For example, if a
user on the "finance@example.com" distribution list forwards the message to "joesmith@example.com"
who is not on the distribution list, Joe can access the message because his email address is on the
"example.com" domain. Joe will also need to sign in to view the message. You can track all users who
access the message. See Track message activity.

If you mark an existing user account as an external distribution list, that account will not be able to
access its shared folders and files. If you unmark the address, access to that content will be available
again.

Your Kiteworks administrator determines whether you can mark addresses as external distribution lists.

This indicates an
| external distribution
list.

To £ distribution list@company.com ¥ athena.manager@kiteworks.com ¥ irving.collaborator@kiteworks.com x

To mark an address an external distribution list:

In the navigation pane, click Compose.
In the To field, enter the email address of the distribution list.
Click the email address of the distribution list.

In the pop-up box, select the External Distribution List checkbox.

To +E distributionlist@company.com X

¢ distribution.list@company.com

distribution.list@company.com

External distribution list

Unmark addresses as external distribution lists

Any user with permission can unmark an email address so that it is no longer an external distribution list.

To unmark an address as an external distribution list, click the distribution list email address, and then
clear the External Distribution List checkbox.

Kiteworks Web User Guide Page 38



Manage your inbox

Allow others to track message activity

Allow others to track message activity

When sending a message, you can give internal users and distribution lists the ability to track the
message activity. Tracked activity includes when the message was viewed, replied to, forwarded, and
deleted by a recipient. It also includes when a file attachment was viewed, downloaded, copied, or sent
by a recipient to another user.

Users with tracking access see the activity of message recipients and the activity of other users (non-
recipients) given tracking access. They can also see the message body, its list of recipients and Bcc
recipients, and download file attachments from the message. Additionally, they can send the activity
details to other users and export the activity to a CSV file.

You can give tracking access to the original message recipients and to non-recipients if they are internal
users. Original recipients can access the tracked activity directly from the email they received. Non-
recipients receive an email notification with a link to access the message in the Kiteworks Web
application.

Tracking access is available only in Kiteworks Enterprise applications. Additionally, your Kiteworks server
administrator determines whether you can grant tracking access to other users.

Grant tracking access

To grant tracking access:

In the navigation pane, click Compose.
Compose your message, and then click the Tracking Access link.

To roanviewer@kiteworks.com @

cc Bee | & Tracking Access —I Give tracking
aCCess.,
Project files
Fattach: B B @ ‘ sanssefifv 14+ = = = =E E X' X, &
Here are the files we discussed at today's meeting. Attachments: 2 items

(Expire: May 22, 2024)

Training Presentation.pptx (787.3

KEB) x

Training Video.mp4 (18.1 MB) X
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In the Tracking Access row, click next to the information icon and enter the email addresses of the
users you want to track the message activity.

To roanviewer@kiteworks.com @

Cc
You can give tracking
| access to message
recipients and non-
recipients.

PTrackingAccessﬂ roan.viewer@kiteworks.com @ irving.collaborator@kiteworks.com @

Project files

‘ sansserifr 14 B I = = = = = X' X, =

Fatach: B B QG

Here are the files we discussed at today‘s meeting. Attachments: 2 items
(Expire: May 22, 2024)

Training Presentation.pptx (787.3 X
KB)

Training Video.mp4 (18.1 MB) x

Click Send and confirm you want to grant tracking access to the specified recipients.

Edit tracking access

After sending the message, you can grant additional access or revoke access to message activity.

To edit tracking access:

In the navigation pane, go to your Sent & Tracked folder.
Open the message you sent with tracking access.
In the Tracking Access row, click Edit, and then enter or remove email addresses as needed.

Sent & Tracked » Message

~ | | # Forward | | T Move to Trash | ’ =1 Print

| 3 Reply all

Project files

A athena.manager@kiteworks.com

£ Tracking Access:  irving.collab i ks.com  Edit Edit tracking access
to add or remove
USErs.
3|21m|c‘hm|:-:ats_l“ g Ir..a.mingﬂpresentatlon.pp:x o :0 1]'r..a|ningq.\."|deo.mpd -
2. Withdraw Lv", a B send 3] Id

Click Send and confirm you want to update tracking access to the message activity.
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Track message activity

If you sent a message, or were given permission to track a message's activity, you can track when the
message was viewed, replied to, forwarded, and deleted by a recipient. You can also track when a file
attachment was viewed, downloaded, copied, or sent by a recipient to another user. Additionally you
can send the activity details to yourself and export the activity to a CSV file.

You can track message activity in the following ways:
o Create tracking dashboards to track message activity
e Open individual messages to track activity

Create tracking dashboards to track message activity

Create dashboards to track the activity of messages you sent to recipients, and messages you sent from
shared mailboxes. You can configure a dashboard to track a subset of messages based on subject line
keywords, messages that contain file attachments, and messages sent during a specific time period.

Dashboards » Tracking Dashboard & [ Export csv | | 1 Delete |
Source (messages to track) v
Search mailbox: Recipients Subject

manager.test@kiteworks.com hd All recipients @
Has attachments Sent date @

O Yes O No ® Some From: 47172024 To: No end date

EMEssages sent ] (6 out of 6 have attachments)
Messages Messages with Attachments Viewed Messages with Attachments Downloaded
W\
W \\ AR
. N R\
Messages not viewed _:\'I \ \\\ \\\\ ::!5:: § 1\\\\\
o
\ \ \ WY Ne: 2
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The dashboard shows whether a recipient opened or previewed the message, and downloaded any file

attachments. When monitoring activity:

o Messages that you did not send, but were granted tracking access by the message sender are also
tracked and marked with the key # icon and name of the message sender.

e Inthe Tracked Activities column, dark green icons indicate activity by all recipients, light green icons

indicate activity by some recipients, and red icons indicate no recipient activity.

¢ In the Attachments column, clicking a file attachment link shows the activity details for that file. You
can also click the View Details link see all activity for the message and send or export the full activity

report.

collaborator.test@kiteworks.com  Protected message regarding
tomorrow's event

collaborator.test@kiteworks.com  Files to discuss at tomorrow's
meeting

&L downloader.test@kiteworks.com, Presentation from today's training

viewer test@kiteworks.com Sender: collaborator.test@kitewar

ks.com

* Event Flyer.docx
* Event Introduction.docx

(Expires in 29 days)

* Event Flyer.docx

* Event Introduction.docx
* Training Presentation.pptx
* Training Video.mp4

(Expires in 28 days)

* Training Presentation.pptx

(Expires in 31 days)

Apr 30

Apr 17

View details

""" View details

Your user profile on the server determines whether you can create tracking dashboards. For assistance,

contact your Kiteworks administrator.
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To create a tracking dashboard:

In the navigation pane, click Tracking Dashboards.
On the Tracking Dashboard page, click New Dashboard.

A name is automatically assigned to the dashboard that includes the date and time you
created it. To edit the name, click the ¢ (Edit) button.

Configure the dashboard filter, and then click Save.

Table 5. Tracking dashboard filter settings

Property Description

Search mailbox This field contains the email address corresponding to your inbox. If you are
also a member of a shared mailbox, you can select the email address of the
shared mailbox to monitor the activity of its message recipients.

Recipients The activity of all message recipients is tracked by default. To narrow the filter
to specific recipients, enter their email addresses.

Subject To track a subset of messages based on keywords in message subject lines,
enter the keywords. Otherwise all messages received by the specified
recipients will be tracked on the dashboard.

Has attachments  Specify whether to track all messages or only messages containing file
attachments.

Sent date Select the time period during which to track message activity.

To edit a tracking dashboard:
On the Tracking Dashboard page, click the dashboard name.
To edit the name, click the ¢ (Edit) button.
Edit the dashboard filter, and then click Save.
To export a tracking dashboard:
On the Tracking Dashboard page, open the dashboard containing the activity you want to export.
In the upper right corner of the page, click Export to CSV to export the full activity report.
To delete a tracking dashboard:

On the Tracking Dashboards page, in the row of the dashboard you want to delete, click #¢+ > Delete.

Open the dashboard, and then click Delete.
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Open individual messages to track activity

To track message activity:

1 Perform one of the following actions:

o If you sent the message, go to your Sent & Tracked folder. Open the message, or in the Tracked
Activity column click Track.

o If you are a message recipient and you were given tracking access, open the message to view the
activity in the Tracked Activity pane.

o If you are not the message sender, but received a "Tracking Notification" email, open the email
and click the Access Message button.

2 In the Tracked Activity pane, click a column heading to view the corresponding activity for all listed
users, or click a checkmark to view the activity for the corresponding user.

@ Tracked Activity

Q (3] . .
- %] €@ Clickheadingsand
Lscintc) 23 (173) checkmarks to view
corresponding activity
RECIPIENTS details.

roanviewer@k.. £
MNOM-RECIPIENTS WITH TRACKING ACCESS
ining.collabora... &

OTHERS (ANYOME WITH THE MESSAGE LINK) @

athena.manager...

III View details
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3 To view, send, or export the full activity report, click View Details.

Tracking Details x

Sent Email

Date:
Jubgect:

To:

Activity

athena.manager@kiteworks.com

oday, %57 AM pdated track [
irving.collaborator@kiteworks.com &£

e B A g MEess
roan.viewer@kiteworks.com &

‘est ] EER igwes T :
Yesterday A Vie a P at

Send report || Export C5V || Clase |
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Fill out forms

You can use secure web forms to upload sensitive information such as legal evidence, insurance claims,
medical data, and so on. Forms can standardize the input of information required by your processes.

Your Kiteworks administrator creates the forms you can access when creating an email message.
To fill out a form:

In the navigation pane, click Compose.
If you're sending the message from a shared mailbox, select the mailbox in the From list.
At the top of the page, click the Fill Out Form link and select the form.

Your Kiteworks administrator may set a form to open automatically when you compose a
message. You can click the Fill Out Form link to select a different form or to compose an email
message instead.

Enter the email addresses of the recipients.
Fill out the form, and then attach any files or folders you want to send.

The maximum allowed size of all folder attachments is 1.3 GB. Your Kiteworks administrator
may lower the size limit.
To set an expiration date for file attachment links, add security and more, click the Message Security
Settings link at the top of the page.

Click Send.

EKG Submission Form  (Fill Out Formv)

@ Message Security Settings:  Access: Original recipients only. Message Body: Protected.
Attachments: Expire Oct 19, 2023

To ekg-automation@localhospitalorg X Bec

EKG Submission for Interpretation

Message

& attachFiles: B | B | @G system-uiv 14+ | B I U S| A ~| 3

Attachment: 1 item
(Expires: Aug 4, 2022)

patient.ecg (61 Bytes) X

feRequestlhg Physician
Physician's last, first, M

*Physician / Practitioner Number

*EKG Type
CPET
Insurance
® HMO Member
3rd Party in System
3rd Party Qut of System

Out of Pocket
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Table 6. Message settings

Setting* Description

Who has access to  Specify who can access the message, including when it's forwarded to others.

your sent content  your Kiteworks server administrator determine which options are available to
(including you, including the ability to allow recipients to access the message using one-time
forwards) passcodes.

Allow recipients to Send recipients one-time passcodes to access the message instead of signing in

use one-time- with their user names and passwords. Recipients will still have the option to sign

passcodes to in or create an account to access the message.

access the Depending on the options available to you, you may be able to email or text

message recipients the one-time passcodes. If texting passcodes, when you send the
message you'll be prompted to enter or confirm mobile numbers.

Recipients must Require recipients sign in to view the message body and list of file attachments. If

sign in to view the the user does not have an account on the server, they'll be prompted to create
message body and one to view the message.

file attachments In your Sent & Tracked folder, the @ indicates a secure message.

list
Select this option to enhance security. Exposing the message
body to non-authenticated users allows any user who receives a forwarded copy
of the message to view the message and list of file attachments. You also lose the
ability to track and withdraw the message.
If you don't select this option, the message is still sent securely through
Kiteworks. While non-authenticated recipients will see the list of file attachments,
they will need to sign in to download the file attachments.
The subject line will be visible to recipients.

Attachments Links expire on the date you specify at 23:59:59 (11:59:59 PM) UTC time.

expire

Notify me when Email yourself a report listing the files that expired and whether recipients

attachments opened, downloaded, or copied them to a folder.

expire

You don't need to wait until files expire to track their activity. After sending
files, open your Sent & Tracked folder in the Kiteworks Web application and next
to the message click Track.

Display the SHA3- Include an SHA3-256 digital fingerprint with each file attachment for those

256 digital recipients who want to verify the integrity of the file. Recipients can use a third-
fingerprint next to  party tool to verify that each file has not been altered.

each file

attachment

Notify me when Email yourself a time-stamped notification that includes the name of the file and

attachments are the email of the person who downloaded it. You can also choose to notify other
downloaded. Also  users as well.
notify:
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Table 6. Message settings (continued)

Setting* Description

Send attachments  Allow authorized recipients to view the files, but not download them. To view the
as view-only files  files, they must sign into the server.

Send attachments  Allow authorized recipients to view the files, while preventing them from
as DRM protected  copying, printing, or modifying the files in any way.

files Recipients view DRM protected files in the secure Kiteworks viewer. They can
open the files directly from their email messages and download links to the files
for use later. To view the files, they must sign into the server.

Send me a copy Email yourself a copy of the message.

* Your user profile on the Kiteworks server determines which settings you can see and can modify. For
assistance, contact your Kiteworks administrator.
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Manage your mail attachment quota

Most file attachments in your mailbox count towards your mailbox size. If you have a limit, as you
approach it you'll receive an email notification recommending you free up space. Once you reach the
limit, you won't be able to send files and others won't be able to upload files to your Inbox.

These are the types of attachments that count towards your quota.

e Attachments in your Sent & Tracked folder, including attachments in messages you forwarded to
others.

e Attachments in your Drafts folder.
e Attachments that others uploaded to your Inbox at your request.

You can manage your space from your account settings page. Click your account profile picture, and then
click Settings > Account.

1.9 GB of 2.0 GB used

Manage mail attachments

To create space, you can delete messages you don't need. You can also delete specific attachments from
messages. On the Account tab, click Manage Mail Attachments.

0 Delete 1of5 £ ¥
Settings » Mail Attachments 85 attachments . 1.9 GB of 2.0 GB used
Name Size subject Modified ~  Mail type
@ [8) site video.mps 4513KB  Site Videos 0138PM  Draft *+ ——Youcanalsoopena
message to deleteitor
L2 @ Annuzl Report.docx 2189KB  Project files 12:42 PM Sent o specific attachments
Ci @ Business Plan.docx 204.1 KB Project files 12:42 PM Sent
| @ Budget Presentation.pptx 789.7 KB Project files 12:42 PM Sent
C @ Event Flyer.docx 217.4 KB Project files 12:42 PM Sent
¥ @) Event Introductiondocx 16MB  Project files 1242PM Sent
td @ Training Presentation(irving.collaborator@accellion.com).pptx 789.7 KB Reply to: Reguest for project files Feb 13 Request
“ [%) Budget Presentation(keby.upleader@aceellion.com).ppix 789.7KB  Reply to: Request for project files Feb 13 Request
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Withdraw file attachments from sent messages

If you make a mistake after sending files to others, you can withdraw the file attachments from the sent
message. The file links are deactivated so that recipients can't access the files. The message itself is not
withdrawn.

If a recipient forwards a message before you withdraw it, the links in the forwarded message remain
active until the file attachments expire.

To withdraw a file attachment:
In the navigation pane, click Sent & Tracked.
Open the message containing the file attachment you want to withdraw.

Select the attachment, and then click Withdraw.

& 4 attachments: Event FI o (/] .
yer.do Event Introduction.docx
ires: May 29, 202 s g e
Expires: May 29, 2024 Mma 218.3 KB @ 1.6 MB

Training Presentation.pptx -

b
[ o 2. Withdrawn

787.3 KB

2. withdraw &b Download B send (3 save to folder
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Withdraw messages

If you make a mistake after sending a message, you can withdraw the message from your Sent & Tracked
folder. Withdrawn messages contain single-line strikethrough formatting, and the “Withdrawn” label is
added to the "Subject" and "Attachments/Expiration" columns.

When you open a message you withdrew, a message banner indicates that the message was withdrawn
and the date and time it was withdrawn. When you track your message activity, the tracking details also
indicate the date and time the message was withdrawn.

Keep the following in mind:

e You can withdraw only “protected” messages -- that is messages you sent that require recipients to
sign in to view the messages.

e When a recipient tries to view a withdrawn message in their inbox on any platform, the message
subject indicates that the message was withdrawn and is no longer available.

To withdraw a message:

In the navigation pane, click Sent & Tracked.
Select the message you want to withdraw, and then click Withdraw.

Sent & Tracked
To Subject Sent Attachments/Expiration Q Tracked Activity
Haberatertest@iitewarks: Withdrawn Pretecteds regardingtemere. 1244 PM 2@ (Withdrawn)
collabarataor.test@kiteworks.com  Files to discuss at tomorrow's meeting = Here are t.. Apr 29 4@ (29 days left)
viewer.test@kiteworks.com Annual Report for current fiscal year Apr 17 1& (17 days left)
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Delete and recover messages

Delete messages

To delete a message:

In your inbox, select the message you want to delete, and then click Move to Trash.

Recover messages

If you accidentally delete messages from your inbox, you can recover them while they're still in your
Trash folder.

Your Kiteworks administrator determines how long deleted messages remain in the Trash folder, and the
time period during which recovery is allowed.

To recover a message:

In the navigation pane, click Trash.

Select the message you want to recover, and then click Restore.

Permanently delete messages

If your system is configured to save deleted messages for recovery, you can also permanently delete
those messages.

To permanently delete a message:

In the navigation pane, click Trash.
Select the message you want to delete, and then click Delete.
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Create and edit folders

You store your files in secure folders which you can share with other users for collaboration. You can
create folders from scratch or upload folders from your desktop or Repositories Gateway sources.

You create folders on the All Files page in your Kiteworks source. This source may be named "Kiteworks
Files" or it may have been given a different name by the server administrator.

The All Files page also includes a default folder called "My Folder". Your Kiteworks administrator may
require that you create your folders within it. The "My Folder" folder is provided as a way for you to
share subfolders and optionally sync file changes to folders on your desktop. If you can create folders at
the same level as My Folder, you can also sync those top-level folders to your desktop. To sync files, you
need to install and run the Kiteworks for Desktop client on your desktop. For instructions, see the
Kiteworks for Desktop User Guide.

When creating subfolders, keep the following information in mind:

o Subfolders inherit the security settings from the top-level (or root) folder. Before you create a
subfolder, modify the security settings in the top-level folder to suit your needs.

e To create a subfolder, your role in its parent folder must be Owner, Manager, or Collaborator.

When creating a folder, your administrator may give you the option to use system storage for the folder
instead of your personal allocated storage allowance. If you choose to use system storage quota, you will
see the number of system storage folders you can create and the maximum amount of storage allocated
to you. You can choose the amount of storage to use from your total storage quota allowance. Your user
profile on the Kiteworks server determines whether you can create folders that use system storage.
Additionally, system storage folders can be only top-level (or root) folders.

New folder X

Folder name

Sandstone Project

Folder description

Folder quota

Use my storage quota ~ Use system storage quota )

{Unlimited available) (5 folders available)

Security settings
L] Allow desktop sync
[ Restrict downloads @

Folder expiration

MNever expires al

File expiration (in days)

30 days

EEEC m
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To create a folder:
From the All Files page, click your Kiteworks source, browse to where you want to create the folder,
and then click New > Folder.
On the New Folder page, enter a name and description for the folder.

If you are creating a top-level folder and you have the option to choose between using personal
storage or system storage, select the storage option you want. If you select "Use system storage
quota", you will also be able to select the amount of storage to use from your total storage quota
allowance.

Specify other folder settings, and then click Save. See Folder security settings.

Edit folder properties

You can edit folder properties to rename the folder, revise the folder description, and change the folder
security settings.

To edit folder properties, your role for the folder must be Owner or Manager.

To edit folder properties:

Right-click the folder, and then click Folder Properties.
Click +#+ > Folder Properties.
Edit the folder properties and security settings, and then click Submit.

Table 7. Folder security settings

Property Description

Allow desktop sync Enable you to sync the folder to a folder on your desktop.

To sync folders, install and use the Kiteworks for Desktop client on your desktop.
For instructions, see the Kiteworks for Desktop User Guide.

You can edit this setting only in top-level folders you created.

Restrict downloads Limit the sharing and downloading of the folder and its files to only you and the
folder manager. Folder members assigned the Collaborator role will be able to
edit files using only the internal application editor, not the file's source
application.

In the folder list, you can identify restricted folders by the shield ©7 next to the
folder date column.

You can restrict only top-level folders in your Kiteworks source folder. If
you're creating a subfolder, this option is not available.

Folder expiration  Select the date you want the folder to be deleted from the server.
Subfolders inherit the folder expiration setting from the top-level folder.

File expiration Select the date you want the files in the folder to be deleted from the server.

Subfolders inherit the file expiration setting from the top-level folder.
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Upload folders

When uploading folders, ensure that each folder contains one or more files. Some browsers will not let
you upload empty folders.

To upload folders to other folders, your role in the destination folders must be Owner, Manager, or
Collaborator.

To upload a folder:

Browse to where you want to upload the folder, and then click Upload > Upload a Folder.

Select and upload the folder.
Most browsers will let you drag folders from your desktop or Repositories Gateway source to
Kiteworks folders.

Edit the folder properties and security settings. See Folder security settings.
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Share folders

You can invite users to become folder members so that they can securely access and collaborate on files
in those folders. Depending on the roles you assign them, folder members can review, download, and
edit files, share files with other users, add comments, and more.

To share folders, your role for those folders must be Owner or Manager.

To share a folder:

In the folder you want to share, open the Information & Tracked Activity pane.
Click the Members tab, and then click Invite New Member.
Enter the email addresses of the users you want to invite.

As you type, suggestions are made from your Contacts list in the Kiteworks Web application.
You may also be able to search your company directory for an address. New addresses are added to
the contacts list.

Select a role to assign to the new folder members. For a list of roles and what people assigned to
them can do, see Folder roles and permissions.

You can change individual user roles after you send the invitation.
To notify recipients that you shared the folder with them or to subscribe them to file notifications,
select the corresponding notification options. Folder members with the appropriate roles can also
subscribe to file notifications on their own.

If you prefer to send a custom email to notify new folder members, after you send your
invitation you can email them a link to the folder. From the Information & Tracked Activity pane, click
"Copy Link" and paste it into your message.

To share the folder, click Save.

Invite members to Sandstone Project X

Email (Use tab or semicolon to separate multinle email addresses

testuseri@kiteworks.com X testuser2@kiteworks.com

Invite as

Collaborator v @

Notify recipients that the folder has been shared with them

] Notify recipients when someone adds a file to the folder

Kiteworks Web User Guide Page 57



Manage folders

Share folders

Folder roles and permissions

Table 8. Permissions for working with folders

Action Owner Manager Collaborator Downloader Viewer Uploader*
Add folders to v v N v v -
Favorites

Change user access v N4 - - - _

to folders

Create folders v v v - - _

Delete folders

-- Nonrestricted v v N4 - - _
folders

-- Restricted folders v N - - - _
-- Top-level folders v v - - - -
-- Delete folders v N - - - _

permanently

Download folders

-- Nonrestricted v v v N4 - v
folders

-- Restricted folders N N - - - _
Edit folder v v v - - _
properties

Leave folders N N v N N v
Move folders v Vv - - - _
Rename folders N v - - - _
Recover folders v v - - _
Send messages to v v - - _
folder members

Share folders v v - - - _
Subscribe to folder N N v N N -
notifications

Upload folders Vv Vv v - - _
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Share folders

Table 8. Permissions for working with folders (continued)

Action Owner Manager Collaborator Downloader Viewer Uploader*

View and download v N N - - -
folder activity (from

the Information &

Tracked Activity

pane)

View folder details v v v v v -
(from the

Information &

Tracked Activity

pane)

View folder N N v - - -
members

View folder v v v - - -
properties

* Users assigned the Uploader role can see and work with only folders they upload to a shared folder.

Table 9. Permissions for working with files

Action Owner Manager Collaborator Downloader Viewer Uploader*
Add comments to N4 N N N - -
files

Copy files

-- Nonrestricted N4 N N N - -
folders

-- Restricted folders N4 N4 - - - -
Create and edit v N N - - N
Microsoft Office

files

Create and edit N4 N4 N4 - - -
tasks

Delete files

-- Nonrestricted N4 N N - - v
folders
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Table 9. Permissions for working with files (continued)

Action Owner Manager  Collaborator = Downloader Viewer Uploader*
-- Restricted folders v v - - - _
-- Delete files v v - - - -

permanently

Download files

-- Nonrestricted v v N4 N4 - N4
folders

-- Restricted folders N4 N4 - - - _
Edit their own v v v v - _
comments

Edit file expiration v v v - - _
dates

Edit files in the app v v v - - -
editor

Lock and unlock

files

-- Personal files v v v - - -
-- Other user files v v - - - -
Manage file v v v - - _
versions

Move files

-- Nonrestricted v v If allowed by - - v
folders administrator

-- Restricted folders v v - - - -
Open files v v v v v v

Push files to folder
member devices

-- Nonrestricted v v - - - _
folders

-- Restricted folders - - - - - _

Recover files v v v - - _
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Table 9. Permissions for working with files (continued)

Action Owner Manager  Collaborator = Downloader Viewer Uploader*
Rename files v v v - - v
Request files v v v - - -
Send files

-- Nonrestricted v v v v - v
folders

-- Restricted folders - - - - - _

Share files

-- Nonrestricted N4 N4 - - - _
folders

-- Restricted folders - - - _ _ _

Upload files to v v Vv - - V4
folders

View and annotate v N4 v - - _
PDFs

View comments N4 N4 N4 N - -

* Users assigned the Uploader role can see and work with only files they upload to a shared folder.
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Change user access to folders

After you've shared a folder with users, you can reassign individual user roles. You can also revoke a
user's access to the folder.

To change user access to folders, your role for those folders must be Owner or Manager.
To reassign a folder member role:

Select or open the shared folder, and then open the Information & Tracked Activity pane.
On the Members tab, click the arrow next to the user's role, and then select the new role.

In the folder, click More > Manage Members. Click the arrow next to the user's role, and
then select the new role.

© Tracked Activity Members

M manager.test@kiteworks.com

Ouner To delegate folder management to a folder
C collaborator.test@kiteworks.com member, assign them the Manager role.
Collaborator = Managers have full access to the folder and

downloader test@kiteworks.com its files, including permisson to share it with

D Downloader = other users and reassign roles.
v viewer.test@kiteworks.com

Viewer™
U uploader.test@kiteworks.com

Uploader=

Invite new member

To revoke access to a folder:

Select or open the shared folder, and then open the Information & Tracked Activity pane.
On the Members tab, click the arrow next to the user's role, and then click Remove Member.

In the folder, click More > Manage Members. Click the arrow next to the user's role, and
then click Remove Member.
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Manage folder notification settings

Folder notifications are messages sent to your email when someone uploads a file to a shared folder,
adds a new file version, edits a file, comments on a file, or copies or moves a file to the folder.

To receive notifications, you must turn them on for each folder you want to monitor. A folder owner or
manager may also do this for you when they invite you to share the folder. You can subscribe or
unsubscribe to folder notifications at any time.

To reduce frequent notifications, when files are added to the same folder within a short time period,
you'll receive a single email with all of the notifications in one message. From there, you can access the
folder to view the corresponding activity.

To subscribe or unsubscribe from notifications, your role for the folder must be Owner, Manager,
Collaborator, Downloader, or Viewer.

Viewers can't view file comments. If you need to view them, ask the folder owner or manager
to change your role.

To manage folder notification settings:

Right-click the folder, and then click Manage Notifications.
Click ##¢+ > Manage Notifications.

Select or clear the notification settings, and then click Submit.
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View and export folder and file activity

You can view user activity associated with a folder and its files. Folder activity includes when a folder
member updated the folder properties, added folders, and shared the folder with other users. File
activity includes when a folder member viewed, downloaded, copied, or sent the file to another user.

When viewing high-level folder or file activity, you can click View Details to access and export the full
activity report.

Folder and file activities are tracked using secure, time-and-date stamped event log records. Information

includes the action that was performed, the name of the user who performed it, and the date it
happened.

When you export the folder activity, the following information is exported in the activity report:
e The date and time the action occurred.

e The email address of the user who performed the action.

e The action that occurred.

e The folder path.

e For a file action, the file name and its size.

o For files that were viewed or downloaded, the SHA3-256 digital fingerprint is associated with the file.
The fingerprint enables you to verify the integrity of the file and that it was downloaded successfully.

e For an action that impacted another user, the email address of the recipient. For example, if the
folder was shared with a user or a file was sent to a user, their user name is included in the report.

To view and export folder activity, your role for the folder must be Owner, Manager, or
Collaborator.

To view and export folder activity:

Select the folder or file containing the activity you want to view.
In the folder or file row, click the Track button.

Kiteworks
&Download ‘ ‘ -I]T]- Delete 2a Members v *** pore v
Sandstone Project X
Hawthorne Project Today, 2:32 PM 4 items
12 Sandstone Project (1] Today, 2:31 PM 5 items
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2 In the Information & Tracked Activity pane, click the check mark to view recent activity by a user.

¢ At the folder level, a check mark in the Accessed column indicates the user accessed one or more

files in the folder. If you selected a file, it indicates the user accessed that file.

o At the folder level, a check mark in the Modified column indicates the user modified the folder. If

you selected a file, it indicates that the user modified that file.

© Tracked Activity Members

Q Activity tracked in:

= Vi
c collaborator.test wccessed  Modified
(member, collaborataor)
v
Accessed Folder &
v

Downloaded "Annual Report.docx”
Today, 2:09 PM

Viewed "Annual Report.docx”
Today, 2:09 PM

@® viewer.test@kiteworks.com

@ uploader.test@kiteworks.com

i= View Details

3 To view and export the full activity report, click View Details. On the Tracked Details page, you can:

o Search to find activity by a specific user.

o Specify a date range for the activities.

e Show activity for only internal users (in your company) or external users.
e Export the report.

Folder Activity (Only the first 1000 events are shown. To see mare activity, export the report.) B Export CsV
collaborator.test Date:  Last 7 days % Members: B @ Internal M = External

Date = Members = Activity =

Yesterday, 1:43 PM © collaborator.test Added a comment to "Annual Report.docx”

Jun 20, 2023, 2:10 PM © collaborator.test Sent "Annual Report.doc:” to: viewer. test@kiteworks.com

Jun 20, 2023, 2:09 PM ¢ collaborator.test Downloaded "Annual Report.docx”

Jun 20, 2023, 2:09 PM © collaborator.test Viewed "Annual Report.doc:”

4 To export the results, click Export CSV.
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Date/Time (GMT) User Action Relative folder path File/Folder Name  Filesize File-fingerprint Member/Recipient
6/20/2023 18:24 manager.test@kiteworks.com update_folder Sandstone Project  Sandstone Project - - -
6/20/2023 18:13 manager.test@kiteworks.com update_folder Sandstone Project  Sandstone Project - - -
viewer.test@kiteworks.com

6/20/2023 18:10 collaborator.test@kiteworks.com  send_mail Annual Report.docx  Annual Report.docx - -
6/20/2023 18:09 collaborator.test@kiteworks.com download Sandstone Project  Annual Report.docx 228005 de07651fb05ad6f9aad377aa63c3e8f9
6/20/2023 18:09 collaborator.test@kiteworks.com view file Sandstone Project  Annual Report.docx 228005 de07651fb05ad6f9aad377aa63c323f9
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Add folders to your Favorites list

You can add folders you frequently use to your Kiteworks Favorites list.
To access your Favorites list, in the navigation pane, click Favorites.

To add a folder to your Favorites list:
In the folder row, click the Favorite 1 icon.
Right-click the folder, and then click Favorite.
To remove a folder from your Favorites list:
In the folder row, click the Favorite * icon.
Right-click the folder, and then click Remove as Favorite.
To remove multiple folders from your Favorites list:

In the navigation pane, click Favorites.

Select the folders you want to remove, and then click Remove as Favorite.
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Rename folders

To rename a folder, your role for the folder must be Owner or Manager.
To rename a folder:

Right-click the folder, and then click Folder Properties.
Clicks#+ > Folder Properties.

Type the new folder name, and then click Submit.
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Move folders

You can move Kiteworks folders to other Kiteworks folders. While you can't move folders from
Repositories Gateway sources to Kiteworks, you can always move files from those sources to Kiteworks
folders.

When moving folders, keep the following information in mind:

e Moved folders inherit the properties and folder members assigned to the new parent folder. Folder
members who are not already members of the new parent folder will no longer have access to the
folder. After moving a folder, you may want to edit its properties and settings to add and remove
folder members, adjust folder member roles, and so on.

e You user profile may enable you to move folders you created to the top level in your Kiteworks
source on the All Files page. This source may be named "Kiteworks Files" or it may have been given a
different name by the server administrator. Since top level folders don't have parent folders, the
moved folders and their subfolders retain the properties and folder members assigned to them.

To move folders, your role for the source and destination folders must be Owner or Manager.
If the folder or its subfolders contains locked files, unlock them before attempting to move
the folders.
To move a folder:
Select one or more folders, and then click More > Move.
Right-click a folder, and then click Move.
Select the destination folder, and then click Move Here.

You can also drag folders to other folders on the same page.
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Leave folders

When you no longer want access to a shared folder, you can remove yourself as a member of the folder.
For example, you may want to declutter your folder list from time to time.

In the future if you want access to the folder, you'll need to ask the folder owner or manager to share it
with you again.

If you don't have the option to leave a folder, you were given access to it as part of your
membership in an LDAP group or mailing list, or the administrator did not provide the option. For
assistance, contact your Kiteworks administrator.

To leave a folder:

In the folder, open the Information & Tracked Activity pane.

On the Members tab, leave the folder in any of the following ways:
e Next to your role, click the arrow, and then click Leave Folder.

e At the bottom of the pane, click Leave Folder.

© Tracked Activity Members

collaborator.test@kiteworks.com )
c Collaborator = Click the arrow next to your role to

leave the folder.

M & Leave folder peom
You can also leave the folder from
D downloader.test@kiteworks.com the bottom of the pane.
Downloader

v viewer.test@kiteworks.com

Viewer

U uploader.test@kiteworks.com
Uploader

A lcavefolder #€= - = = = = = = = = = |- - - oo
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Delete and recover folders

You cannot delete the following folders:

e "My Folder", if your system includes this default folder.

e Folders containing locked files.

When deleting top-level folders, you can select only a single folder to delete at a time.

Deleting folders and files may be permanent. However, your company policy may permit you to recover
deleted or expired folders and files, or permanently delete items you're saving for recovery.

Delete folders

Before you delete a folder, you may want to consider these alternatives:

o Edit the folder properties to limit what users can do with the files. You can restrict the folder to
prevent users with the Collaborator role from sharing, sending, or downloading the folder and its
files.

e Lock the folder files to prevent users from editing or overwriting the files. Keep in mind that when
users with the Owner, Manager, or Collaborator role copy locked files to other folders, the file copies
get unlocked in the destination folder.

If you want to create a backup of the folder before deleting it, you can also download the folder and its
files to your desktop.

e To delete top-level folders, your role for the folders must be Owner or Manager.
e To delete subfolders, your role for the subfolders must be Owner, Manager, or Collaborator.

To delete a folder:
Right-click the folder, and then click Delete.

At the end of the row, click *#+ > Delete.

To delete multiple folders:
Select each folder checkbox, and then click Delete.

Recover folders

Your role and the Kiteworks folder policies set up by your Kiteworks administrator determine whether
you can recover deleted or expired folders, and the time period during which recovery is allowed.

To recover folders, your role for the folders must be Owner or Manager.
To recover a folder:

Open the folder from which you deleted the subfolder.
In the Information & Tracked Activity pane, click See More to expand the details.

Next to the Deleted label, click the link to the deleted folder. If the link is not displayed, you don't
have permission to recover deleted folders.

In the list of deleted folders, right-click the folder you want to recover, and then click Recover.

Kiteworks Web User Guide Page 71



Manage folders

Delete and recover folders

Permanently delete folders

If your system is configured to save deleted folders for recovery, you can permanently delete those
folders.

To permanently delete folders, your role for the folders must be Owner or Manager.
To permanently delete a folder:
Open the folder from which you deleted the subfolder.

In the Information & Tracked Activity pane, click See More to expand the details.

Next to the Deleted label, click the link to the deleted folder. If the link is not displayed, you don't
have permission to deleted folders.

In the list of deleted folders, right-click the folder you want to delete, and then click Permanent
Delete.
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Upload files to folders

You can upload files of any size securely to your Kiteworks folders from your desktop. Once uploaded,
you can share the folders so that folder members can access the files.

You can upload folders using Chrome, Firefox, Microsoft Edge, and Safari browsers.
To upload a file:
From the top of any folder list, click Upload > Upload Files.

Select one or more the files, and then upload them to the folder.

From an open folder on your desktop or Repositories Gateway source, drag one or more
files to the folder.

23 uploading) v

Kiteworks > Sandstone Project fctintios
X upload v~ ‘ + New v ‘ 22 Members v In progress Cancel all
B Upload files > w Uploading to Sandstone Project (3 uploading) n X
[ ] Upload a folder Site Video.mp4 »

Uploading (14% complete)
Training Presentation.pptx x
Uploading (8% complete)

Training Video.mp4 x

Uploading (0% complete)
Completed Clear all

* Uploaded to Sandstone Project (3 uploaded)

@ Annual Report.docx
@ Expense Spreadsheet.xlsx
@ Project Scope Report.pdf

Kiteworks Web User Guide Page 74



Manage files

Share files

Share files

You can share individual files in a folder without giving users access to other files in the folder. Once
shared, users can click the "Shared with me" link in the navigation pane to see files that were shared
with them.

When you share a file, you can assign users the Collaborator role with permissions to edit, download,
send the file, and more. Or you can assign them the Viewer role with limited permissions to work with
the file. Your Kiteworks administrator determines which roles you can assign.

To share or unshare a file, your role in the folder containing the file must be Owner or Manager.
To share a file:

Select the file you want to share, and then click Share File.
Enter the email addresses of the file recipients.

As you type, suggestions are made from your Contacts list in the Kiteworks Web application.
You may also be able to search your company directory for an address. New addresses are added to
the contacts list.

Select a role to assign to the recipients.

When sharing the file with multiple users at the same time, you can select only one role to assign to
all users. After you share the file, you can change the role of an individual user.

Share "Annual Report.docx" X

Email (use semicolon to separate email addresses)

managertest@kiteworks.com @ collaboratortest@kiteworks.com @

Invite as

Collaborator v | @

~ Collaborator

Viewer
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4 While sharing the file you also have the option to copy a link to the file for use in other applications.

Share "Annual Report.docx” X

Email (use semicolon to separate email addresses)

managertest@kiteworks.com € collaboratortest@kiteworks.com €

Invite as

Collaborator v | @

Message (Optional)

Copy Link

5 To share the file, click Share.
6 To change the role you assigned to a user, select the file again. Open the Information & Tracked
Activity pane, click the Members tab, and then select a different role for the user.

| Information & Tracked Activity ¥

Kiteworks » Sandstone Project

@ Tracked Activity Members Comments

| & Download | | @ pelete | I £ Edit content ¥ | | B> send file [ | > Share file | | *ar Maore v ‘

File shared with all folder members and...
X Shared
C collaborator.test

B=| Annual Report.docx €  Feb 13 2023 by monagertest 222.7 KB Collaborator =
a_: Brpense Spreadsheetxisx = ot Bnagernbest e D downloader.test@kiteworks.com
ewerv
©| Geclogic Interview (Large File).wav et E anager.test M

To stop sharing a file:
Select the file, and then open the Information & Tracked Activity pane. Click the Members tab, select the
user's role, and then click Stop Sharing.
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Shared file roles and permissions
Table 10. Permissions for working with shared files
Action Collaborator  Viewer
Add comments to files v -
Copy files N -
Create and edit Microsoft Office files (only to add a new version) v -
Create and edit tasks - -
Delete files - -
Download files v -
Edit their own comments v -
Edit file expiration dates - -
Edit files in the app editor v -
Lock and unlock files v -
Manage file versions (only for versions they added) v -
Move files - -
Open files v v
Push files to folder member devices - -
Recover files - -
Remove another user's access to shared files - -
Remove their own shared access to files v v
Rename files - -
Send files v -
Share files - -
View and annotate PDFs v -
View comments v -
View others who have access to shared files - -
Work with files offline v -
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View files shared with you

To view files that have been shared with you, in the navigation pane, click Shared With Me. The person
who shared the file with you determines what you are permitted to do with the file, such as edit,
download, and send the file. You may also be limited to only viewing the file.

Shared with me

Information & &«
Tracked Activity
Name Shared # Updated % Size ¥ 9 Tracked Activity
0= Annual Report.docx 2227 KB f Fi‘l 4 o
B Expense Spreadsheet.xlsx 2 kg e
Project Scope Report.pdf 34,7 KB by e
To see what you can do with a shared file, select the file, and then click More.
Shared with me
Information & &«
‘ X3 Download | ‘ B> send file ‘ | === More v | Tracked Activity
Annual Report.docx X £ Edit content >
1.
=2 Download .
@ Annual Report.docx 2227 KB 2 by e
I Send view-only file
B Expense Spreadsheet.xlsx i) Copy ::'lf‘. i 63.6 K2 -
n
a Llock
Project Scope Report.pdf 347 KB by g e

[ Add new version

& Remove my access

To remove your access to a shared file, select the file and then click More > Remove My Access.

Shared with me

Information & &«
et Download | | B> send file | ‘ *** More ¥ | Tracked Activity
Annual Report.docx X £ Edit content >
¢1 Download M L =
@ Annual Report.docx 2227 KB 2 g e
[ Send view-only file
57 PM o =
B Expense Spreadsheet.xlsx = Copy - 65.6 KB 2 &y g e
n
o Lock =6 PM
J=| Project Scope Report.pdf :H ! UTKB b g e

B Add new version

A& Remove my access
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Open files

You can view and open common file types. To open a file, click the file name.

Your role determines what you can do with the file. You may be able to download it to your desktop,
send it to other users, assign file-related tasks to folder members, and more. If it's a Microsoft Office file,
you may be able to edit the file in its source application. When you save it back to your folder, a new
version replaces the existing one. You can always download, roll back, and delete file versions as needed.
When viewing files, keep the following information in mind:

e For most file collaboration actions, your role for the folder must be Owner, Manager, or Collaborator.
For a complete list of roles and the actions they support, see Share folders.

e Opening a file in the viewer enables you to scroll through all files in the folder, according to their sort
order. Use the left and right arrows on the screen or keyboard to navigate between files in the folder.

o Before you can work with a file opened from a Repositories Gateway source, check the file out from
its source. See Check files in and out of Repositories Gateway sources.

o If you're assigned the Viewer role and can't view videos, ask the folder owner to change your role to
Downloader or higher. It's possible that your Kiteworks administrator enforced watermarking for file
previews and some video files can't be watermarked.

f Edit content v & Download B> send file 2 share file =+ More v X

— |+  Pagefit - T3 Send DRM protected file &N »
n Access the Details
o Lock ™ '
— Comments, and
B Pushfile Shared tabs.
Keys to Success

o Describe unique ar distinguishing factors that will help your business plan succeed @ Copy

B Move

Description of Business
[ Add new version

BB Tasks

@ Delete

bazed d

Location

o Remember that lac:

describe the highlights—poo ©
jide or Gther f3ctors that are sssant
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/ Edit content v rﬁ Download B> Send file 2 Share file *** More ¥

— |+ PageFit v SN »

Keys to Success Details Comments  Shared

ishing fectors that wil helo pour business pizn succeed.

o Deseribe uniqus or diss

Today, 3:40 PM
Madified
Mar 13, 2019, 3:28 AM

Size
204.1 KB
Location

Hawthorne Project

Expiration
unt impartance to some types of businesses, Jess 5o sz Never expires
crations, that cauid be an sdvantsge -
File link

https://latest.accellion.net/w/f-be2c3500-ce7a-4e0c-... |'_D

Shareable with folder members

Manage files

Open files

File name
Description of Business Business Plan.docx ¥ —T— Rename the
file.
Date added

Copythefilelink
toshare with
others.
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Edit files using SafeEdit

SafeEDIT next-generation digital rights management (DRM) enables possessionless editing of shared files
by internal and external users in a browser-based virtual Ul, while the files stay protected in the
Kiteworks server cluster.

While editing a file in SafeEDIT mode, the file is automatically locked, preventing others from editing it.
Locked files are indicated in the web application and your name is listed so that others know you are
editing the file. When you finish editing the file and close your session, the file is unlocked and becomes
available for other users to edit.

When editing a file:

¢ File changes are not saved automatically, even if you turned on the auto-save feature within your
source application, such as Microsoft Word.

e The time allotted for your edit session is displayed at the top of the page. Monitor your session time
and save changes often to avoid losing them when your session ends. You will be prompted to save
your changes one minute prior to the session ending.

e When your session ends, you can restart your session to continue editing the file.

When collaborating with others, if a file is being edited using SafeEDIT, a message next to the file name
indicates that the file is locked for editing and the person who is editing the file. If you are the person
editing the file, you also have the option to end your edit session directly from the file list page instead
of switching to the SafeEDIT window to end the session. Just be sure to save your changes in the file
before ending your session.

Name & Updated # Size % racked Activi
Name + Up $ s Q Tracked Act
a File is being edited by you
EMD SESSION 20 074 3997 ¥ =
@ Annual Report.docx - Jul 29,2024 by 222.7 KB gl e

To edit a file using SafeEDIT:

In the row of the file you want to edit, click £% (Edit Content).
The file opens in SafeEDIT mode.

Pg. 02
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2 Edit the file as needed. When you finish editing the file, close the application and the corresponding
SafeEDIT window.

Note: Some browsers, such as Firefox, don't support copying text from an external source to the
browser. If copying text to your browser is not available, you will see a side panel when editing a file
in SafeEDIT mode. Use this side panel to paste copied text into the SafeEDIT clipboard and then you
can paste the text into your SafeEDIT document.

To paste text using the SafeEDIT clipboard:

1 From your source, copy the text you want to paste into the SafeEDIT document.

2 In the SafeEDIT document, open the side panel (also called "control panel").

Kitewcorks

DIT To end your session, dose the browser or Sig

Mailngs  Revew  View  Help 7 Share

Financial Summary

Usa this section 10 give a brief summary of your financials, highighting important points

You can find easy-to-use tooks on the Insen tab, such as 1o add a hyperink, insert a comenent
or add automatic page rumbsring

s [ I Foous

3 In the side panel, click Clipboard.

Kitewcrks

Control Panel x Madings  Reiew  View  Help

Sound Micraphone a
g
m Clipboard El immary

jive a brief summary of your financials, highighting Enportant paints

taxt n this document indicates the nam of the style applied, 5o that you

samae formatting again

+-use 100ls on the Insert tab, such as to add a hyperink, insert a comment.
ge numbering

Drocs @ B 1
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4 Paste the copied text into the SafeEDIT clipboard, and then paste the test into the SafeEDIT
document.

D ez @

Kitewcrks

Control Panel x Madings  Reiew  View  Help £ Share

Sound Microphone a
E
a Clipboard - immary

jive a brief summary of your financials, highighting Enportant paints

taxt in this document indicates the name of the style applied, so that you

same formating again.

This is text to be copied fr ernal »use fools Insert 1ab, such as 1o add a hyperink, Insert a comement

source to my SafeEDIT dos

ge numbering

L.

Drocs @ [ 1

5 When you finish editing the file, close the application and the corresponding SafeEDIT window.

Kiteworks Web User Guide Page 83



Manage files

Create and edit Microsoft Office files using Kiteworks

Create and edit Microsoft Office files using
Kiteworks

If you have an Office 365 subscription, you can create Microsoft Word, Excel, and PowerPoint files while
maintaining the files securely within Kiteworks. Depending on your system configuration, you may be
able to create the files using your Office desktop or web applications. With Office 365, you can
collaborate with co-authors in real time, simultaneously editing and saving content as you work.

When you edit a file using Kiteworks, a prior version of the file gets saved so that you can view and
access the file history. You can download, roll back, and delete file versions as needed.

For instructions on editing files in Office applications, see the documentation provided with the
applications. If you can't create Office files, contact your Kiteworks administrator to determine if they
configured the Kiteworks server to integrate with Microsoft Office applications.

To create and edit Microsoft Office files, your role for the folders containing the files must be
Owner, Manager, Collaborator, or Uploader.

¢ You must have an Office 365 Enterprise E3 license or above.

o If your Office 365 plan includes the Microsoft Office desktop versions of Word, Excel, and PowerPoint,
you must install those applications on your desktop.

o If you want to use the Office desktop applications to create the files, download and install Kiteworks
for Desktop, and then sign into the client. Otherwise, you create and edit the files using only Office
online. For instructions, see the Kiteworks for Desktop User Guide.

To create a file:

In the Kiteworks folder, click New > Microsoft Office Document.
Select the Office files you want to create, and then type a name for the file.
File names can't contain these characters: \ /: * " |
If the Office desktop application is installed on your desktop, the file is initially created using
the desktop application. Once you close the file, when you want to edit it again, you can choose to
edit the file in the Office desktop application or using Office Online.
To edit a file:

Right-click the file, click Edit, and then select whether to use the desktop or online version of the Office
application.
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Copy files

When copying files to folders, keep the following information in mind:

o Copied files inherit the file expiration settings assigned to the destination folders.

¢ You copy only the files, not the file versions, comments, and tasks associated with the files.
e When you copy locked files to folders, the copies get unlocked in the destination folders.

e When you copy and replace files in a folder, new versions of the files are created in the destination
folder if file versions are allowed by your Kiteworks administrator. This enables you to download, roll
back, and delete file versions as needed.

To copy files, your roles for the source and destination folders must be Owner, Manager, or
Collaborator. If you're assigned the Manager or Collaborator role and you don't see the option to copy
files, your company security policy may prevent all users from copying files. For assistance, contact your
Kiteworks administrator.

To copy a file:

Select one or more files, and then click More > Copy.
Right-click a file, or select and then right-click multiple files, and then click Copy.
Select the destination folder, and then click Copy Here.
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Move files

When moving files to folders, keep the following information in mind:

You can move only unlocked files to folders.
Moved files inherit the file expiration settings assigned to the destination folders.

When working with Repositories Gateway sources, you can move files only between Dropbox and
your Kiteworks folders.

When you move and replace files in a folder, new versions of the files are created in the destination

folder if file versions are allowed by your Kiteworks administrator. This enables you to download, roll
back, and delete file versions as needed.

To move files, your roles for the source and destination folders must be Owner or Manager. If

you're assigned the Collaborator role, you may see that you have permission to move files.
Administrators can choose to allow collaborators to move files.

To move a file:

Select one or more files, and then click More > Move.

Right-click a file, or select and then right-click multiple files, and then click Move.

Select the destination folder, and then click Move Here.

You can also drag files to other folders on the same page.
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Rename files

To rename a file, your role for the folder containing the file must be Owner, Manager, or
Collaborator.

If the file was locked by another user, unlock the file. You cannot rename files that are
locked by other users.

To rename a file:

Right-click the file name, and then click Rename File.
Click #++ > Rename File.

Type the new file name, and then press Enter.
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Lock and unlock files

You can lock files to prevent other users from editing and moving the files, uploading new versions, and
deleting the files from Kiteworks.

e To lock and unlock files, your role for the folder containing the files must be Owner, Manager, or
Collaborator.

e To unlock files that were locked by other users, your role for the folder containing the files must be
Owner or Manager.

To lock or unlock a file:

Perform one of the following actions:

e To lock or unlock a file, right-click the file, and then click Lock or Unlock.
Click#** > Lock or Unlock.

¢ To lock or unlock multiple files, select each file checkbox, and then click ##¢+ > Lock or Unlock.
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Manage file versions

Each time you edit or replace a file in Kiteworks, a prior version gets saved so that you can roll back or
download a version if needed.

You can also upload file versions to the version history without editing the current file in Kiteworks. You
can even assign the file version a different name and add it to the version history. The file does not
become the current file version unless you make it the current file.

To view, add, and roll back file versions, your role for the folders containing the file must be
Owner, Manager, or Collaborator.

To manage file versions:

Select the file containing multiple versions.
In the Information & Tracked Activity pane, click See More to expand the details.
Next to the Versions label, click See Version History.
In the version history, you can perform the following actions:
e To roll back to a prior version, in the row of the file you want to make current, click Make Current.
e To delete a prior file version, click Remove.
To upload a file version:

In the file list, right-click the file for which you want to add a version, and then click Add New Version.
Click #++ > Add New Version.
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Edit file expiration dates

A folder owner typically edits folder properties to set the expiration date for all files in that folder.
However, if your role enables you to change the time period for when a specific file is accessible to users,
you can change the file expiration date for that file.

Keep the following information in mind:

¢ Your Kiteworks administrator determines whether you have the option to edit the expiration date of
individual files.

e If you're not the folder owner, you can set an expiration date only within the time period set by the
owner.

o If you want to immediately expire a file link, set the current date as the expiration date. The file gets
deleted from the server at the end of the day. Your Kiteworks administrator determines whether you
can recover deleted files.

¢ Links expire on the date you specify at 23:59:59 (11:59:59 PM) UTC time.
To edit file expiration dates, your role for the folder containing the files must be Owner, Manager,
or Collaborator.

To edit the file expiration date:

Right-click the file, and then click File Expiration.
Click #+* > File Expiration.
Select an expiration date, and then click Submit.

You can also edit the file expiration date wherever the file details are listed, such as in the
Information & Tracked Activity pane and when you open a file in the viewer. In the file details, click the
expiration link, and then edit the date.
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Check files in and out of Repositories Gateway
sources

When you want to edit files in Repositories Gateway sources, you can check the files out from the
source, edit the files, and then check them back in to the source.

Keep in mind that some content sources lock files you check then out so that other users can't edit the
files until you return them to the source.
To check a file out of a Repositories Gateway source:
From the All Files page, open the source containing the file you want to check out.
Right-click the file name, and then click Copy/Move.
Click *##+ > Copy/Move.
Select the Kiteworks folder where you want to place the file, and then click Copy.

To check a file into a Repositories Gateway source:
In the Kiteworks folder, right-click the file name, and then click Return to Source.
Click ##+ > Return to Source.
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Delete and recover files

Before you delete files, keep the following information in mind:

o If you delete files that were pushed to folder member devices for offline use, the files are also deleted
from those devices.

e You can delete only unlocked files.

o Deleting folders and files may be permanent. However, your company policy may permit you to
recover deleted or expired folders and files, or permanently delete items you're saving for recovery.

Delete files

To delete afile, your role for the folder must be Owner, Manager, or Collaborator.
If the folder is a restricted folder, only the folder owner and folders members with the
Manager role can delete files from the folder.
To delete a file:
Right-click the file, and then click Delete.
At the end of the row, click +++ > Delete.

To delete multiple files:
Select each file checkbox, and then click Delete.

You can also lock files to prevent users from editing or overwriting them. Keep in mind that
when users with the Owner, Manager, or Collaborator role copy locked files to other folders, the file
copies get unlocked in the destination folder.

Recover files

Your role and the Kiteworks folder policies set up by your Kiteworks administrator determine whether
you can recover deleted or expired files, and the time period during which recovery is allowed.

To recover files, your role for the folders containing the files must be Owner or Manager.

To recover a file:

Open the folder from which you deleted the file.
In the Information & Tracked Activity pane, click See More to expand the details.

Next to the Deleted label, click the link to the deleted file. If the link is not displayed, you don't have
permission to delete files.

In the list of deleted files, right-click the file you want to recover, and then click Recover.
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Permanently delete files

If your system is configured to save deleted files for recovery, you can also permanently delete those
files.

To permanently delete files, your role for the folders containing the files must be Owner or
Manager.

To permanently delete a file:

Open the folder from which you deleted the file.
In the Information & Tracked Activity pane, click See More to expand the details.

Next to the Deleted label, click the link to the deleted file. If the link is not displayed, you don't have
permission to recover deleted files.

In the list of deleted files, right-click the file you want to recover, and then click Recover.
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Send files and folders

You can send files securely using Kiteworks. The files are uploaded to your Kiteworks server and a link is
sent to recipients to access the files. After the link expires, the files are deleted from the server.

You can send files from Kiteworks folders, your desktop, and from Repositories Gateway sources. You
can send folders only from your desktop and Repositories Gateway sources.

When sending folders, keep the following information in mind:
e Folder attachments will be zipped for distribution.

e The maximum allowed size of all folder attachments is 1.3 GB. Your Kiteworks administrator may
lower the size limit.

o |f the folders contain subfolders, ensure that each folder contains one or more files. Some browsers
may not let you upload empty folders to send.

¢ You can send folders from your desktop using Chrome, Firefox, Microsoft Edge, and Safari browsers.
If a recipient doesn't have a user account on the server, they'll be prompted to create one.

To send files from folders, your role for the folders must be Owner, Manager, Collaborator,
Downloader, or Uploader.

Restricted Kiteworks folders and files in them can't be sent.
To send files and folders:

In the navigation pane, click Compose.

If you're sending a single file, in the file row click Send File.
If you're sending the message from a shared mailbox, select the mailbox in the From list.
If you're filling out a form, click the Fill Out Form link, and then select the form.

Your Kiteworks administrator may set a form to open automatically when you compose a
message. You can click the Fill Out Form link to select a different form or to compose an email
message instead.

Enter the email addresses of the recipients.

As you type, suggestions are made from your Contacts list in the Kiteworks Web application.
You may also be able to search your company directory for an address. New addresses are added to
the contacts list.

If you're filling out a form, a predefined email address may get entered for you.
Compose your message or complete the form, and then add any files and folders you want to send.

If you want to allow others to track the message activity, click the Tracking Access link. In the Tracking
Access row, click next to the information icon and enter the email addresses of the users you want to
have tracking access. See Allow others to track message activity.

To set an expiration date for file attachment links, add security and more, click the Message Security
Settings link at the top of the page.
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Click Send.

o If a policy requires approval for sending files, you will be notified that your message has been
paused while pending approval. Approvers will be notified and when one of the approvers
approves your action, you will be notified and your message will be sent. You may need to refresh
your browser window to update the status. If your action is denied, you will also be notified and
the message will remain in your Kiteworks outbox where you can edit and resend the message or
delete it.

¢ As the message is processed, it's stored in the Kiteworks Outbox folder. Files are scanned for
security, so it may take a moment for the message to be sent. If a recipient doesn't receive your
message in their external email application, ask them to check their spam or junk email folder to
determine if the message was misidentified.

o If arecipient doesn't receive your message in their external email application, ask them to check
their spam or junk email folder to determine if the message was misidentified.

Compose Message (Fil Out Formw)

@ Message Security Settings:  Access: Original recipients only. Message Body: Protected.
Attachments: Expire Oct 19, 2023 Increase security, set

attachment expiration

date, and more.

To “Irving Collaborator® X Bec
Cc

Project files Select and pin sources

| from which to attach
‘ files.

& attachfies: B | B | G|l & | @& | e

sansserifv 14« | B I U & =] ~

Here are the files we discussed at today's meeting. Attachments: 2 items
(Expire: Dec 31, 2022)

Annual Report.doox X
(222.1 KB)

Sandstone Project Folder.
zip (58.6 MB)

Table 11. Message settings

Description

Who has access to  Specify who can access the message, including when it's forwarded to others.

your sent content  yoyr Kiteworks server administrator determine which options are available to

(including you, including the ability to allow recipients to access the message using one-time
forwards) passcodes.
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Table 11. Message settings (continued)

Setting* Description

Allow recipients to Send recipients one-time passcodes to access the message instead of signing in

use one-time- with their user names and passwords. Recipients will still have the option to sign
passcodes to in or create an account to access the message.

access the Depending on the options available to you, you may be able to email or text
message recipients the one-time passcodes. If texting passcodes, when you send the

message you'll be prompted to enter or confirm mobile numbers.

Recipients must Require recipients sign in to view the message body and list of file attachments. If
sign in to view the the user does not have an account on the server, they'll be prompted to create
message body and one to view the message.

file attachments In your Sent & Tracked folder, the @ indicates a secure message.

list
Select this option to enhance security. Exposing the message
body to non-authenticated users allows any user who receives a forwarded copy
of the message to view the message and list of file attachments. You also lose the
ability to track and withdraw the message.
If you don't select this option, the message is still sent securely through
Kiteworks. While non-authenticated recipients will see the list of file attachments,
they will need to sign in to download the file attachments.
The subject line will be visible to recipients.

Attachments Links expire on the date you specify at 23:59:59 (11:59:59 PM) UTC time.

expire

Notify me when Email yourself a report listing the files that expired and whether recipients

attachments opened, downloaded, or copied them to a folder.

expire You don't need to wait until files expire to track their activity. After sending

files, open your Sent & Tracked folder in the Kiteworks Web application and next
to the message click Track.

Display the SHA3- Include an SHA3-256 digital fingerprint with each file attachment for those

256 digital recipients who want to verify the integrity of the file. Recipients can use a third-
fingerprint next to  party tool to verify that each file has not been altered.

each file

attachment

Notify me when Email yourself a time-stamped notification that includes the name of the file and

attachments are the email of the person who downloaded it. You can also choose to notify other
downloaded. Also  users as well.
notify:

Send attachments  Allow authorized recipients to view the files, but not download them. To view the
as view-only files  files, they must sign into the server.
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Table 11. Message settings (continued)

Setting* Description

Send attachments  Allow authorized recipients to view the files, while preventing them from
as DRM protected  copying, printing, or modifying the files in any way.
files Recipients view DRM protected files in the secure Kiteworks viewer. They can

open the files directly from their email messages and download links to the files
for use later. To view the files, they must sign into the server.

Send me a copy Email yourself a copy of the message.

* Your user profile on the Kiteworks server determines which settings you can see and can modify. For
assistance, contact your Kiteworks administrator.
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Send view-only files

You can send files that users can view, but not download from the server. You can send files up to 300
MB and recipients must sign into the server to view them.

View-only files are converted to image files to prevent their contents from being copied or returned in
search results. A secure badge indicates that the file is protected and limited to view-only access.

If you send files to someone who doesn't have a user account on the server, they'll receive an email with
instructions on how to create an account so that they can access the files.

Your user profile determines whether you have the option to send view-only files.

To send files from Kiteworks folders, your role for the folders must be Owner, Manager,
Collaborator, Downloader, or Uploader.

Restricted folders, and files in those folders, can't be sent.

To send a view-only file:

Select one or more files to send.

You can also right-click a file to send it.
At the top of the page, click More > Send View-Only File.
Enter the email addresses of the recipients.

As you type, suggestions are made from your Contacts list in the Kiteworks Web application.
You may also be able to search your company directory for an address. New addresses are added to
the contacts list.

If you want to allow others to track the message activity, click the Tracking Access link. In the Tracking
Access row, click next to the information icon and enter the email addresses of the users you want to
have tracking access. See Allow others to track message activity.

To set an expiration date for file attachment links, add security and more, click the Message Security
Settings link at the top of the page.
Send the message.

As the message is processed, it's stored in the Kiteworks Outbox folder. Files are scanned for
security, so it may take a moment for the message to be sent. If a recipient doesn't receive your
message in their external email application, ask them to check their spam or junk email folder to
determine if the message was misidentified.

If a recipient doesn't receive your message in their external email application, ask them to check their
spam or junk email folder to determine if the message was misidentified.

Table 12. Message settings

Description

Who has access to  Specify who can access the message, including when it's forwarded to others.

Your sgnt content  yoyr Kiteworks server administrator determine which options are available to
(including you, including the ability to allow recipients to access the message using one-time
forwards) passcodes.
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Table 12. Message settings (continued)

Setting* Description

Allow recipients to Send recipients one-time passcodes to access the message instead of signing in

use one-time- with their user names and passwords. Recipients will still have the option to sign
passcodes to in or create an account to access the message.

access the Depending on the options available to you, you may be able to email or text
message recipients the one-time passcodes. If texting passcodes, when you send the

message you'll be prompted to enter or confirm mobile numbers.

Recipients must Require recipients sign in to view the message body and list of file attachments. If
sign in to view the the user does not have an account on the server, they'll be prompted to create
message body and one to view the message.

file attachments

I In your Sent & Tracked folder, the ©7 indicates a secure message.
ist

Select this option to enhance security. Exposing the message
body to non-authenticated users allows any user who receives a forwarded copy
of the message to view the message and list of file attachments. You also lose the
ability to track and withdraw the message.

If you don't select this option, the message is still sent securely through
Kiteworks. While non-authenticated recipients will see the list of file attachments,
they will need to sign in to download the file attachments.

The subject line will be visible to recipients.

Attachments Links expire on the date you specify at 23:59:59 (11:59:59 PM) UTC time.
expire

Send attachments  Allow authorized recipients to view the files, but not download them. To view the
as view-only files  files, they must sign into the server.

Default watermark Add watermark text to overlay the file.

text Your Kiteworks administrator may provide default watermark text to display with
your custom text on the file, such as the email address of the person viewing the
file, your email address, and the date the file was sent.

Send me a copy Email yourself a copy of the message.

Notify me when Email yourself a report listing the files that expired and whether recipients
attachments opened, downloaded, or copied them to a folder.

expire

* Your user profile on the Kiteworks server determines which settings you can see and can modify. For
assistance, contact your Kiteworks administrator.
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Send DRM protected files

When you want to share sensitive files, you can send them as DRM protected files. DRM controls ensure
that only authorized recipients can view the files, while preventing them from copying, printing, or
modifying the files in any way.

Recipients view DRM protected files in the secure Kiteworks viewer. They can open the files directly from
their email messages and download links to the files for use later. To view the files, they must sign into
the server.

Here is some additional information to keep in mind:
¢ You can send most types of viewable files, including Microsoft Office files, PDFs, and image files.

¢ In recipient email messages, the DRM protected files are given the ".kws.url" file extension to indicate
they are viewable only in the secure viewer.

¢ If you send files to someone who doesn't have a user account on the server, they'll receive an email
with instructions on how to create an account so that they can access the files.

e Your user profile determines whether you have the option to send DRM protected files.

To send files from Kiteworks folders, your role for the folders must be Owner, Manager,
Collaborator, Downloader, or Uploader.

Restricted folders and files in them can't be sent.
To send a DRM protected file:

Select one or more files to send.

You can also right-click a file to send it.
At the top of the page, click More > Send DRM Protected File.
Enter the email addresses of the recipients.

As you type, suggestions are made from your Contacts list in the Kiteworks Web application.
You may also be able to search your company directory for an address. New addresses are added to
the contacts list.

If you want to allow others to track the message activity, click the Tracking Access link. In the Tracking
Access row, click next to the information icon and enter the email addresses of the users you want to
have tracking access. See Allow others to track message activity.

To set an expiration date for file attachment links, add security and more, click the Message Security
Settings link at the top of the page.

Click Send.

o If a policy requires approval for sending files, you will be notified that your message has been
paused while pending approval. Approvers will be notified and when one of the approvers
approves your action, you will be notified and your message will be sent. If your action is denied,
you will also be notified and the message will remain in your Kiteworks outbox where you can edit
and resend the message or delete it.

o As the message is processed, it's stored in the Kiteworks Outbox folder. Files are scanned for
security, so it may take a moment for the message to be sent. If a recipient doesn't receive your
message in their external email application, ask them to check their spam or junk email folder to
determine if the message was misidentified.

o If arecipient doesn't receive your message in their external email application, ask them to check
their spam or junk email folder to determine if the message was misidentified.
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Table 13. Message settings

Setting* Description

Who has access to  Specify who can access the message, including when it's forwarded to others.

your sent content  your Kiteworks server administrator determine which options are available to
(including you, including the ability to allow recipients to access the message using one-time
forwards) passcodes.

Allow recipients to Send recipients one-time passcodes to access the message instead of signing in

use one-time- with their user names and passwords. Recipients will still have the option to sign
passcodes to in or create an account to access the message.
access the

Depending on the options available to you, you may be able to email or text
message recipients the one-time passcodes. If texting passcodes, when you send the
message you'll be prompted to enter or confirm mobile numbers.

Recipients must Require recipients sign in to view the message body and list of file attachments. If
sign in to view the the user does not have an account on the server, they'll be prompted to create
message body and one to view the message.

file attachments

I In your Sent & Tracked folder, the ©7 indicates a secure message.
ist

Select this option to enhance security. Exposing the message
body to non-authenticated users allows any user who receives a forwarded copy
of the message to view the message and list of file attachments. You also lose the
ability to track and withdraw the message.

If you don't select this option, the message is still sent securely through
Kiteworks. While non-authenticated recipients will see the list of file attachments,
they will need to sign in to download the file attachments.

The subject line will be visible to recipients.

Attachments Links expire on the date you specify at 23:59:59 (11:59:59 PM) UTC time.
expire

Send attachments  Allow authorized recipients to view the files, while preventing them from
as DRM protected  copying, printing, or modifying the files in any way.

files Recipients view DRM protected files in the secure Kiteworks viewer. They can

open the files directly from their email messages and download links to the files
for use later. To view the files, they must sign into the server.

Default watermark Add watermark text to overlay the file.

text Your Kiteworks administrator may provide default watermark text to display with
your custom text on the file, such as the email address of the person viewing the
file, your email address, and the date the file was sent.

Send me a copy Email yourself a copy of the message.

* Your user profile on the Kiteworks server determines which settings you can see and can modify. For
assistance, contact your Kiteworks administrator.
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Request files from users

You can ask users to upload files to your shared folders or to your inbox. Having users upload files to
your inbox enables you to distribute the files more efficiently. From the message you can quickly send
the files to others or save them to the folders you choose.

If you're a member of a shared mailbox, you can also request files to the shared mailbox inbox on behalf
of the shared mailbox group. Shared mailbox members receive the request from the shared mailbox, not
the user who sent the request. Requested files get uploaded to the shared mailbox inbox, not to
individual group member inboxes.

Whether you ask someone to upload files to a folder or to your inbox, you have full control over the
number of files they can upload and when the upload links expire.

To help you identify the person who uploaded a file, their email address is appended to the file name. If
you save the file to a folder, you can rename it in the folder.

e Request files to folders
e Request files to your inbox
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To request files to a folder your role for the folder must be Owner, Manager, or Collaborator. To

request files to your inbox, you can be assigned any role.
To request files to a folder:

Open the folder, and then click Request Files.

Right-click the folder, and then click Request Files to Folder.

Enter the email addresses of the recipients.

As you type, suggestions are made from your Contacts list in the Kiteworks Web application.
You may also be able to search your company directory for an address. New addresses are added to

the contacts list.

Compose your email, and then click Request Settings to specify additional settings, such as the

expiration date for the upload link. See Request file settings.
Click Send Request.

Request File to folder: Sandstone Project

To collaborator.test@kiteworks.com €

Subject: File request | Request files from today's presentation

Message

sans-serifr 14+ B I U & A ~

Hi Collabarator,
Please upload the presentations and videos from today's training session to this folder,

Thank you.

Request settings =

Require authentication for file uploads

Limit number of file uploads to: |5

Upload link expires 06/29/2024 M  (Date format: mm/d

Allow uploader to view selected files in this folder @ : 2 files selected | Browse files

Send request

If a recipient doesn't receive your message in their external email application, ask them to check their

spam or junk email folder to determine if the message was misidentified.
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Request files to your inbox

To request files to your inbox:

Next to the Compose button, click the arrow, and then click Request Files to Inbox.

Your Kiteworks administrator determines whether you can access the arrow next to the
compose button to request files from users.

If you are requesting files to a shared mailbox, select the mailbox in the From list.
Enter the email addresses of the recipients.

As you type, suggestions are made from your Contacts list in the Kiteworks Web application.
You may also be able to search your company directory for an address. New addresses are added to
the contacts list.

Compose your email, and then click Request Settings to specify additional settings, such as the
expiration date for the upload link. See Request file settings.

Click Send Request.

Request files to inbox e X
To collaborator.test@kiteworks.com @

Subject: File request | Request files from today's presentation

Message

sans-serif» 14 B I U & A -~

L]
U]
I
n
=
®
oy

Hi Collaborator,
Please upload the presentations and videos from today's training session to my inbox.

Thank you.

Request seftings w
Require authentication for file uploads
Limit number of file uploads to: 5
Upload link expires  06/29/2024 B  (Date format: mm/dd/y

Notify others when files are uploaded: | downloadertest@kiteworks.com @

| Cancel ‘ Send request

If a recipient doesn't receive your message in their external email application, ask them to check their
spam or junk email folder to determine if the message was misidentified.
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Request file settings

Table 14. Request Files to Inbox settings

Setting* Description

Require Require recipients sign in to upload files. If they don't have an account on the
authentication for  Kiteworks server, they'll be prompted to create one.

file uploads

Limit number of Specify the number of files each recipient can upload.

file uploads

Upload link expires Links expire on the date you specify at 23:59:59 (11:59:59 PM) UTC time.

Link never expires  The link doesn't expire unless you withdraw the message.

Allow uploaderto  When requesting files to a folder, specify which files in the folder recipients can
view selected files access while uploading their files to the folder. When they reach their upload

in this folder limit, they can continue to use the upload link to access viewable files until the
link expires.

Notify others When requesting files to your inbox, send an email notification to other users

when files are when the files are uploaded to your inbox. They won't have access to your inbox.

uploaded

* Your user profile on the Kiteworks server determines which settings you can see and can modify. For
assistance, contact your Kiteworks administrator.
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Send messages to folder members

From your shared folders, you can email folder members to notify them of changes to the folder,
communicate project information, and more. Each recipient receives an email message containing a
secure link to sign in and access the folder.

To send messages to folder members, your role for the folder must be Owner, Manager, or
Collaborator.

To send a message to folder members:

Open the shared folder.
Click More > Message to Members.
Right-click the shared folder, and then click Message to Members.

In the To line, click and select All Members. If you want to send the message to a subset of folder
members, select or enter the recipients individually.

Compose your message.

If you want to secure the message body so that recipients must sign in to view the message body,
select the "Recipients must sign in to view the message body" checkbox.

Select this option to enhance security. Exposing the message body to non-
authenticated users allows any user who receives a forwarded copy of the message to view the
message and list of file attachments. You also lose the ability to track and withdraw the message.

If you don't select this option, the message is still sent securely through Kiteworks. While non-
authenticated recipients will see the list of file attachments, they will need to sign in to download the
file attachments.

Click Send.

Message to members

To Enter one or more folder member email addresses. Bee

Su ﬁ' All Members

1 Owner, 1 Collaborator, 1 Downloader, 1 Viewer

Owner | S

collaborator.test@kiteworks.com
Collaborator

M manager.test@kiteworks.com

downloader.test@kiteworks.com
Downloader

O

V viewer.test@kiteworks.com
Viewer

Message Security Settings

Recipients must sign in to view the message body

Cancel
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Download files and folders

You can download files and folders for modification, distribution, and other purposes. When you
download multiple items at the same time, they are zipped for distribution.

To download files or folders, your role for the folders must be Owner, Manager, Collaborator, or
Downloader.

If the folder is a restricted folder, only the folder owner or users with the Manager role can
download the folder and its files.

To download a folder or file:

Perform one of the following actions:

e To download a file or folder, select or right-click the item, and then click Download.

o To download multiple files or folders, select each item's checkbox, and then click Download.

If a file has multiple versions, you can also download a prior version of that file. Select the file
checkbox, and then in the details section of the Information & Tracked Activity pane, click See Version
History.
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Push files to folder member devices

You can push files from a Kiteworks folder to the devices of folder members for them to access while
offline. For each file you push, each folder member receives an email notification with a link to access
the file in the mobile app. They can edit the files while offline, and then upload the latest file versions to
the folder when they connect to the Internet. You can use the Kiteworks Web application to access file
versions and view the edits made by folder members.

To push files to devices, your role for the folder containing the files must be Owner or Manager.
If the folder is a restricted folder, no user can push files to devices.
To push files to folder member devices:
Perform one of the following actions:
e To push a file to devices, right-click the file name, and then click Push File.
e To push multiple files to devices, select each file checkbox, and then click More > Push File.
To remove files from folder member devices:
Perform one of the following actions:
e To remove a file from devices, right-click the file name, and then click Un-Push File.

« To remove multiple files from devices, select each file checkbox, and then click More > Un-Push File.
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requesting that a folder member review and edit a file by a specific date.
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When you assign tasks to folder members, they receive email notifications describing their assignments,
along with secure links for accessing the files. You also receive copies of the notifications.

To create tasks, your role for the folders containing the files must be Owner, Manager, or

Collaborator.

To create a task:

Right-click the file for the task you want to create, and then click Tasks.

On the Tasks page,
Describe the task you want the user to perform, and then assign the task to a folder member.
Click in the date box to select a due date for the task, and then click Create Task.

I Edit content v

Keys to Success

he oI

& Download

o Describe unigue o disting

Give 3 pasltive, conclse, and fact-based description of your business:

click New Task.

B> sendfile > Share file *** More ¥

— |4+ PageFit hd
B Lock

B push file
i) Copy
@ Move

ishing factors that will help your business plan succeed

Description of Business

I:B Add new version

[ Send DRM protected file

If you have not 2l
or an expansion of

Location

o Remember that loc|

R e EH Tasks
M Delete
" s or service)
ses or permits are required, describe the requirements hem and where you are

Tasks - Expense Spreadsheet.xlsx X
© Tasks can only be assigned to folder membe
L= <

T

A
Please review expenses.
Assignee Status

Kiteworks Web User Guide

Page 110



Collaborate with others

Create and edit tasks

Edit tasks

Whether you created the task or were assigned it, you can edit a task to update its status, assign it to a
different folder member, and more. When you edit a task, an email is sent to the person who created
the task to inform them of the change and you receive a copy of the notification.

To edit tasks assigned to other folder members, your role for the folders containing the files must
be Owner, Manager, or Collaborator.
To edit a task:

Access the task in one of these ways:
» Right-click the file containing the task you want to edit, and then click Tasks.

¢ In the email containing the task assignment, click View Task, sign in to Kiteworks, and when the file
opens in the viewer, click Tasks.

In the Tasks list, point your mouse to the right of the task properties, and then click Properties 4.
Edit the task, and then click Save. For example, you can perform these actions:

e Revise the task description.

e Assign the task to a different folder member.

e Change the status of the task. For example, if you complete the task, change the status to
Completed, and then assign the task back to the person who assigned it to you.
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Add comments to files

You can add comments to files to communicate information to users working on the same project.
Folder members can view and respond to your comments.

e To add, edit, or delete your file comments, your role for the folder containing the file must be Owner,
Manager, Collaborator, or Downloader.

e To view comments from other folder members, your role for the folder must be Owner, Manager,
Collaborator, or Downloader.

To add a comment:
Add a comment in one of these ways:

o Select or open the file. In the Information & Tracked Activity pane, click the Comments tab, and
then add your comment.

e When responding to a file upload request, click the Upload link in the email message, and then
upload the files. When the file upload completes, click the Comment link next to the file.

Type your comment, and then click Post.

| Information & Tracked Activity
Kiteworks > Sandstone Project

| &b Download | | @ pelete | | 2 Edit content v | | B> send file | | +en More ¥ | e Annual Reportdoox Cr
ided: Feb 8, 2023, 11:12 AM
X
[ Annual Report.doot (2]
B2 Expense Spreadsheetalss g e . @ Tracked Activity Members Comments
Project Scope Report.pdf F [ ertest 4.7 C Reviewed the document

@] Training Presentation.pptx

Cancel m

Please review this document.

To view, edit, or delete a comment:
Once you delete a comment, you can't undo your action.
Select the annotated file, and then click the Comments tab.

Point your mouse to the right of the comment properties, and then perform one of the following
actions:

e To edit a comment, click Edit %], edit the comment, and then click Save.
e To delete a comment, click Delete TI.

To reply to a comment:

To reply to a comment, just add another comment. Each comment you add becomes part of the
conversation.
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Use the application editor to edit Microsoft Office and PDF files

Use the application editor to edit Microsoft Office
and PDF files

When you want to ensure leak-proof editing and preventing unauthorized users from duplicating file
content or saving the files to new, unauthorized locations, you can edit the files using the secure editor.

To edit files in the editor, the files must be in restricted folders. In the folder list, you can
identify restricted folders by the shield 7 next to the folder date column.

Table 15. Types of files you can edit in the editor

Application File type Tasks you can perform

Adobe Acrobat .pdf Review and annotate PDFs, create
bookmarks.

Microsoft Word 2007-2013 Document (*.docx) Edit and format content, track changes.

Microsoft Excel 2007-2013 Workbook (*.xIsx) Edit and format content, insert,
rename, and delete worksheets.

Microsoft 2007-2013 Presentation (*.pptx) Edit and format content, add shapes

PowerPoint and other objects to slides.
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Edit files in the editor

e The files must be stored in restricted folders.
e Your role for the folder must be Owner, Manager, or Collaborator.

Install the Kiteworks for Desktop client on your desktop and then sign into it. The desktop
client runs as a task in the background on your desktop enabling you to access Microsoft Office desktop
applications. For instructions, see the Kiteworks for Desktop User Guide.

To open a file in the editor:
In the restricted folder, right-click the file, and then click Edit Content > Kiteworks Editor.

To show the editor toolbar, double-click anywhere in a blank area surrounding a file in the editor.
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Edit Microsoft Word documents in the
application editor

You can use the editor to edit and format text, cut copy, and paste text, and delete text from Microsoft
Word documents. You can also perform these actions:

e Track changes in Microsoft Word documents.
e View comments added to Microsoft Word documents.

To show the editor toolbar, double-click anywhere in a blank area surrounding a file in the editor.

Track changes in Microsoft Word documents

When you want to record changes you make in a Microsoft Word document, turn on the track changes
feature.

To turn on track changes in a Microsoft Word document:

On the toolbar, click Tools > Track Changes.

To activate the revision options, click Track Changes.

Specify how you want to show changes in the document, and then click Done.
See Track Changes options

To accept or reject changes in a Microsoft Word document:

On the toolbar, click Tools > Track Changes.
To show the list of changes in the revision pane, click Original with Markup (Read-only).
In the list of changes, perform one of the following actions:

o To accept or reject individual changes, click the change you want to accept or reject, and then click
Accept or Reject.

e To accept or reject all changes, click Accept All or Reject All.

Table 16. Track Changes options

Option Description

Original (Read- Hide all changes to show the document in its original form.

only)*

Original with Show all changes in relation to the document in its original form. Changes are

Markup (Read- displayed in the revision pane.

only)*

Final Hide all changes to show what the incorporated changes will look like in the final
document.

Final with Markup ~ Show all changes in callouts, while showing what the incorporated changes will
look like in the final document.

* You cannot edit the document while these settings are in place. While editing the document, select
Final or Final with Markup. After editing the document, you can select one of these options to view the
original document with or without markup.
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View comments added to Microsoft Word documents

When the document contains comments added to it in Microsoft Word, you can view those comments in
the editor.

To view comments added to a Microsoft Word document:

On the toolbar, click Tools, and then turn on Show Comments.

To close the comments pane, on the toolbar, click Tools, and then turn off Show Comments.
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Edit Microsoft Word documents in the application editor

Edit Microsoft Word documents

To edit a Microsoft Word document:

Perform any of the following actions:

To insert text, click the insertion point, and then insert the text.

To cut, copy, or delete content, double-click the content, drag the grab points to select content,
and then click Cut/Paste. On the secondary toolbar, click the action, and then click away from the
toolbar until you close it.

To paste content, if the content remains selected in the editor after you copied it, click outside of
the selection box. click the insertion point, and then click Cut/Paste > Paste.

To format text, double-click the text, and then drag the grab points to select text. On the
formatting toolbar, format the text.

When you open secondary toolbars, click outside of the toolbars to close the toolbars.
You can also use keyboard shortcuts to perform actions, such as Ctrl-X, Ctrl-C, and the Delete key.

Changes are typically saved automatically. If necessary, on the toolbar, click Save.

To close a Microsoft Word document, click Close on the toolbar.
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Edit Microsoft Excel workbooks in the
application editor

To show the editor toolbar, double-click anywhere in a blank area surrounding a file in the editor.

To edit a Microsoft Excel workbook:
To edit cell content, click to select the cell, and then click the cell again. Once the cursor appears in
the cell, perform any of the following actions:
e Toinsert text in a cell, click the insertion point, and then insert the text.

e To cut, copy, or delete text from a cell, double-click the text, drag the grab points to select text,
and then click Cut/Paste. On the secondary toolbar, perform the action, and then repeatedly click
away from the toolbar until you close it.

e To paste text, perform one of the following actions:
e To paste text in the same cell, click the insertion point, and then click Cut/Paste > Paste.

¢ To paste text into a different cell, if the text remains selected in the editor after you copied it, click
outside of the selection box. Click to select the cell where you want to paste text, and then click
the cell again. Once the cursor appears, click the insertion point, and then click Cut/Paste > Paste.

You can also use keyboard shortcuts to perform actions, such as Ctrl-X, Ctrl-C, and the Delete key.
To format a cell or row, perform one of the following actions:

o To format a cell, click to select the cell, and then drag the grab points to select text. On the
formatting toolbar, format the cell.

e To format a row, click the first cell in the row, and then drag the grab points to select the row. On
the formatting toolbar, format the row.

To insert or delete rows or columns, perform one of the following actions:
e Toinsert a row or column, click the insertion point, and then on the formatting toolbar, click

e To delete a row or column, click anywhere in the row or column, and then on the formatting
toolbar, click

Changes are typically saved automatically. If necessary, on the toolbar, click Save.
To insert or delete a Microsoft Excel worksheet:

e Toinsert a worksheet, at the end of the row of worksheet tabs, and then click Eg.

e To delete a worksheet, click the tab of the worksheet you want to delete, and then click the x next to
the tab name.

To rename a Microsoft Excel worksheet:

Double-click the worksheet tab.
Type a name for the worksheet, and then click OK.

To close a Microsoft Excel worksheet, click Close on the toolbar.
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Edit Microsoft PowerPoint presentations in the application editor

Edit Microsoft PowerPoint presentations in the
application editor

To show the editor toolbar, double-click anywhere in a blank area surrounding a file in the editor.

To edit a Microsoft PowerPoint presentation:

Perform any of the following actions:

To insert text, click the insertion point, and then insert the text.

To cut, copy, or delete text, double-click the text, drag the grab points to select text, and then click

Cut/Paste. On the secondary toolbar, perform the action, and then click away from the toolbar
until you close it.

To paste text, click the insertion point, and then click Cut/Paste > Paste.

To format text, double-click the text, and then drag the grab points to select text. On the
formatting toolbar, format the text.

You can also use keyboard shortcuts to perform actions, such as Ctrl-X, Ctrl-C, and the Delete key.

Changes are typically saved automatically. If necessary, on the toolbar, click Save.

To add shapes and other objects to a Microsoft PowerPoint presentation:

On the toolbar, click Add > Shapes, and then drag the object you want to the slide.

To format the object, click outside the toolbar repeatedly until you close the toolbar, and then click
the object.

Format the object. You can format objects in these ways:

Change the line type, thickness, and opacity of the object outlines.
Change the outer and inner colors of objects.

Position overlapping objects so that objects appear either in front of or behind each other.
Resize and rotate objects.

In text box objects, double-click to edit and format text.

Changes are typically saved automatically. If necessary, on the toolbar, click Save.

To start and stop a Microsoft PowerPoint slideshow:

To start the slideshow, on the toolbar, click Slideshow.

To stop a slideshow, press the Esc button on your keyboard.

To close a Microsoft PowerPoint presentation, click Close on the toolbar.
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View and annotate PDFs in the application editor

View and annotate PDFs in the application editor

You can use the annotation and drawing markup tools in the editor to add comments to PDFs.
Comments are notes and drawings that communicate ideas or provide feedback on PDFs. You can use
sticky notes to add comments, use the drawing tool to add lines to the document, and highlight text to
annotate it using the associated pop-up note.

You can also create bookmarks to jump to specific pages in the PDFs.

If the files contain annotations or bookmarks added using a different application such as Adobe Acrobat,
you can view those items, but not edit or delete them.

To show the editor toolbar, double-click anywhere in a blank area surrounding a file in the editor.
To add a sticky note:
On the toolbar, click Annotate [Ef, and then drag the sticky note icon to where you want to place the
note.
Double-click the note icon, and then click the icon to open the sticky note.
Below the date and time properties, click the blank area to open the text box.

Type the text, and then click outside the sticky note.
To add a freestyle line:

On the toolbar click Annotate, and then click the freestyle /4 icon.
On the secondary toolbar, click the color |8 icon, and then click the color you want to use for the line.
In the document, draw the line.

To change the color of the line, click the color icon again, click a different color, and then click
outside of the color box.

To adjust the weight of the line, click the weight = icon, click the thickness you want to use, and then
click outside of the weight box.

Perform one of the following actions:
¢ To save the line, click the checkmark 4 icon.

¢ To delete the line, click the close | icon.
To highlight and annotate text:

Double-click the text you want to highlight.

Adjust the selection box, and then click Annotate.

Click the highlight 4 icon, and then double-click the highlighted text to select the text again.
To annotate the highlighted text, click the highlighted text to open the pop-up note.

Below the date and time properties, click the blank area to open the text box.

Type the text, and then click outside the note.
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To view, find, and delete an annotation:

On the toolbar, click Annotations, and then perform one of the following actions:
e To go to a specific annotation, click the annotation in the list.
¢ To delete an annotation, click Select, select the annotation, and then click Delete.

You can also delete annotations from the document itself. To select an annotation, click
the annotation, and then on the toolbar, click Cut/Paste > Delete.

To close the annotations pane, click Annotations.
To edit an annotation:

On the toolbar, click Annotations.
Click Select, and then select the annotation you want to edit.

In the pop-up note, below the date and time properties, click the blank area to open the text box.
Edit the text, and then click outside the note.
To close the annotations pane, click Annotations.
To add a bookmark:
In the document, go to the page where you want to add the bookmark.
On the toolbar, click Bookmarks, and then in the bookmark pane, click Add.
Type a name to identify the bookmark, and then click Done.
To view, find, and delete a bookmark:
On the toolbar, click Bookmarks, and then perform one of the following actions:

e To go to a specific bookmark, click the bookmark in the list.

¢ To delete a bookmark, click the bookmark, and then click Delete.
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Resources

Resources
Get support

Need assistance with your Kiteworks product? Contact us with requests for assistance or to submit
product enhancements.

Contact Kiteworks technical support at https://community.kiteworks.com.

Learn more about Kiteworks products

Visit the Kiteworks Support Portal to read technical articles, view training videos, search the knowledge
base, and download additional user documentation.
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